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Chapter 1 — Introduction 
 
 

This manual describes installation and operation of REVO Remote Pro (Remote Administration System) 

software, which is designed to be used with network cameras, network video transmitters and 
digital/network video recorders (DVRs/NVRs). 
 
 

1.1  Features 
 

REVO Remote Pro is a software that controls monitoring of live video and playback of recorded video 

from devices. 
 

 Remote monitoring of live images from devices 

 Notification of events detected at devices and remote monitoring of the event detected video 

 Panic recording of monitored images 

 Remote software upgrades and system setup 

 Display of device’s system log information 

 Map monitoring of live images 

 Decompression algorithm for H.264, MPEG-4 and M-JPEG 

 Enhanced security using the SSL function 
 Two-way audio communication 

 Operation in a low bandwidth environment 
 
NOTES:  

 In this manual, the “device” refers to a network camera, network video transmitter or digital/network video 
recorder (DVR/NVR). 

 This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit 
(http://www.openssl.org/). 

 The software included in this product contains some Open Sources. You may obtain the complete 
corresponding source code depending on whether or not the source is publicly available under a 
license policy. Go to Client Menu - About page for more information. This product includes software 
developed by the University of California, Berkeley and its contributors, and software developed by the 
OpenSSL Project for use in the OpenSSL Toolkit (http://www.oepnssl.org/). Also, this product includes 
cryptographic software written by Eric Young (eay@cryptsoft.com), and software written by Tim 
Hudson (tjh@cryptsoft.com). 

 The information in this manual is believed to be accurate as of the date of publication even though 
explanations of some functions may not be included. We are not responsible for any problems resulting 
from the use thereof. The information contained herein is subject to change without notice. Revisions or 
new editions to this publication may be issued to incorporate such changes. 
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Chapter 2 — Installation 
 
 

2.1  Product Information 
 

Package Contents 
 
 Installation CD 

 User’s Manual 
 
 

System Requirements 
 
Recommended Requirements 
 

 Operating System: Microsoft®  Windows®  10 64-bit (Home, Pro) (Server OS is not recommended.) 

 CPU: Intel CoreTM i5-3570K 3.30 GHz or faster 

 RAM: 4GB or more 

 VGA: AMD RadeonTM HD 7700 or NVIDIA GeForce GTX650 or higher (1280x1024, 32bpp), multi 

monitor 

 Hard Disk Drive: 6 GB or more free space 

 LAN: Gigabit Ethernet or faster 
 

Minimum Requirements 
 

 Operating System: Microsoft®  Windows®  XP Home SP 3 

 CPU: Intel CoreTM 2 Duo E7200 2.53 GHz  

 RAM: 1.5 GB 

 VGA: AMD RadeonTM HD 2400 or NVIDIA GeForce FX5500 (1024x768, 24bpp) 

 Hard Disk Drive: 1 GB 
 LAN: 10/100 Mbps Ethernet 
 

NOTE: The REVO Remote Pro system performance might deteriorate when simultaneously monitoring or 
playing back multiple videos on a PC with a low specification. 

 

FishEye Client-Side Dewarping Recommended Requirements 
 

 Operating System: Microsoft®  Windows®  10 64-bit (Home, Pro) (Server OS is not recommended.) 

 CPU: Intel CoreTM i7-3770 3.40 GHz or faster 

 RAM: 8GB or more 

 VGA: AMD RadeonTM HD 7700 or NVIDIA GeForce GTX650 or higher (1920x1080, 32bpp), multi 

monitor 
 Hard Disk Drive: 6 GB or more free space 

 LAN: Gigabit Ethernet or faster 
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2.2  Installation 
 
NOTE: Disable your PC’s Windows power saving function: Start menu → Power Options → set both Turn 
off the display and Put the computer to sleep to Never (Power Options → Power Schemes tab → set both 
Turn off monitor and Turn off hard disks to Never when using the Microsoft®  Windows®  XP operating system). 

 

CAUTION: If an older version of REVO Remote Pro software is installed on your computer, 
a screen appears asking you to upgrade the software.  In this case, you are required to 
upgrade the software according to the instructions in the screen. 
1. Insert the software CD in the PC. 

 

2. Run the setup.exe file in the Setup folder of the software CD. 
 

NOTE: The User Account Control window might appear when using the Microsoft®  Windows®  Vista or later 
operating system.  Click Allow and install the software following the instructions. 

 

3. Select the language in which to run the program and then click OK. 

 
 

NOTES:  

 To properly display the selected language, your PC’s operating system should be set to support the 
selected language. 

 To change the REVO Remote Pro program’s language after the software has been installed, run the 
REVO Remote Pro program:  Go to the System menu → Select Setup → Click System. 

 

4. When the following screen appears, click Next. 

 
 
5. Designate the folder path to install the program. 
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6. When the following screens appear, click Next. 
 

  
 

NOTE: .NET Framework and the Visual C++ Runtime Libraries are installed automatically, and it may take 

some time.  This installation step will be skipped if the programs are already installed on your computer. 
 

7. When the following screen appears, click the Close button 

to complete the installation. 

 
 

8. There is no default password.  It is recommended that you 
set up a password for security before using this program. 
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2.3  Uninstall 
 

1. Stop running the REVO Remote Pro program first. 
 

NOTE: The REVO Remote Pro software might not be uninstalled correctly if you uninstall it while the 
program is running. 

 

CAUTION: The REVO Remote Pro software should be uninstalled following the procedures 
below.  If you delete the installation folder manually, the REVO Remote Pro software cannot 
be uninstalled or reinstalled. 
 

2. Go to the Start Menu, and click REVO Remote Pro.  Click Uninstall REVO Remote Pro. 
 

3. Click OK when the following screen appears. 

 
 

4. Click the Remove All or Do not remove button when the following screen appears.  Clicking the 

Remove All button deletes all saved data including panic recorded video and previous settings in the 

system.  Clicking the Do not remove button uninstalls the software without deleting any saved data in 
the system and keeps all saved data in the system. 

 

  
 

NOTE: The deleted data cannot be restored once the data is deleted. 
 

5. Click the OK button to complete the uninstall process. 
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Chapter 3 — Getting Started 
 
 
NOTE: In this manual, the “REVO Remote Pro system” refers to a PC on which the REVO Remote Pro 
program is running and the “device” refers to a network camera, network video transmitter or digital/network 
video recorder (DVR/NVR). 

 

After installing the REVO Remote Pro software, you will find two shortcut icons  of REVO Remote 
Pro and REVO Remote Pro Run as administrator on the desktop.  Double click the REVO Remote 
Pro or REVO Remote Pro Run as administrator shortcut icon to run the REVO Remote Pro program. 

Double click the REVO Remote Pro Run for iHDP shortcut icon to use iHDP exclusively in an easier 
way. 

 

If you have logged as a standard user account instead of an Administrator account in the PC that the 

REVO Remote Pro program is running, you should double click the REVO Remote Pro Run as 
administrator shortcut icon Otherwise, the REVO Remote Pro system does not recognize device’s 
removable/eSATA hard disk drives or SD (SDHC) memory cards. 
 

 

 User ID, Password: Enter the user ID and password of the PC’s 

Administrator account. 

 No Password: Check the box if the PC’s Administrator account 

has no password. 

 Save account information: Check the box if you want to save 
the user ID and password entered above. 

 
NOTE: There might be limitations on logging in depending on the PC’s operating system or User Account 
Control (UAC) setting. 

 

 

3.1  Log In 
 

You are required to log in as follows when running the program. 

 

 

 User ID, Password: Enter your user ID and password.  The 

default user ID is admin and there is no default password.  You 
can change the user ID and password in the User menu.  Refer to 

5.2 User, User Management (p. 28) for details. 

 Remember my ID on this computer: Check the box if you want 
to save your ID for logging on. 

 Restore last Live sessions: Check the box if you want to restore 
the previous live monitoring sessions in the current Live panels 

(not supported for Load user specific layout). 
 

 

3.2  Registering Devices 
 

You must register devices on the REVO Remote Pro program and add the devices to a device group in 
order to perform any operation. 

 

1. Go to the System menu → Select Setup → Select Device. 
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2. Click All Devices in the Site panel, and then the  button at the bottom of the Site List panel.  The 

Device Scan window appears. 
 

 

 

 
 

 
 

 
 

 
 

 Protocol: REVO Remote Pro. 

 Scan Mode: Select the scan mode.  Clicking the Start Scan button displays the results in the list.  If the 
IP address range of the device is different from that of the REVO Remote Pro system, the REVO 

Remote Pro program considers the IP address invalid.  In this case, you must change the device’s IP 

address to register the device. 

− Auto Scan (LAN): Lists devices in a LAN environment (not supported for some models of DVRs). 
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− IP Address: Allows you to enter the IP address of a device.  You can search more than one device 
at a time by entering a range of IP addresses.  It is recommended that the device not be networked 

via DHCP (Dynamic Host Configuration Protocol).  If the device is networked via DHCP, connection 

to the device may not be made properly depending on changes in the external network environment. 

When manually scanning with an IP, the device name is displayed as <no name> before its user 
authentication. 

− DVRNS: Allows you to enter the device name registered on a DVRNS server if the device uses 
the DVRNS (DVR Name Service) function.  Ensure the DVRNS server information on which the 

device is registered is correct (System menu → Setup → Network → DVRNS option).  If the 
DVRNS server information is not correct, the device will not be found. 

− Domain Name: Allows you to enter the device's domain name registered on a DNS server if the 
device uses the Domain Name Service. 

− Device Information File: Allows you to import an .xml file which has device connection information 

and lists the devices.  Select System menu → Setup → Save As File → Device Information 
option to save the current device information and create a file.  Ask your dealer or distributor for 

details about the .xml file. 

  : Select the devices to register by checking the box beside each device name in the list.  Selecting 

the Select All box selects all devices in the list. 
 

3. Click the Add Devices button at the bottom. 
 

 

 

 

 

 

 Name, Address, Device Type: Displays the name, IP address and type of the selected device.  The 

name will be updated automatically when the name set in the device is changed if the Device Name 
Sync option is enabled during the Device setup. 

 ID, Password: Enter the user ID and password which you set in the device in order to connect to that 
device remotely. 

 Apply to All Devices: Select to apply the same user ID and password to all selected devices if you 

selected more than one device and the selected devises have the same user ID and password. 
 

NOTES:  
 If the device is a DVR, it might be necessary to enter the DVR port numbers depending on the 

specifications and version of the DVR. 
 When registering a four-channel network video transmitter, all four cameras are automatically registered 

even if some of the four cameras are disabled. 
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4. Click Device Group in the Site panel, and then the  button at the bottom of the Site panel.  The Add 
Device Group window appears. 

 

  

 

 

 Name: Enter the device group name. 

 Location: Select an upper group to which the device group will belong. 

 Select Devices Below, Selected Device List: Check the box beside cameras in the left panel, and 

the selected cameras are added to the right panel. 
 

Clicking the OK button completes the device group registration. 
 

5. Check that the device was added to the device group correctly.  Click Device Group in the Site panel 

and then the arrow button ( ) beside Device Group.  Clicking the registered group displays the list 

of devices added to the device group in the Site List panel.  Check video analysis ( ) from the device 
group in the case of a device with a video analysis device. 

 

  
 

Selecting the registered device group, and then the  button at the bottom of the Site List panel displays 

the Edit Device Group window and allows you to edit the selected device group.  Refer to 5.1 Device, 
Managing Devices (p. 19) for details. 
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3.3  Live Video Monitoring 
 

 
 

1. Check that the devices were added to a device group in the Site list. 
 

2. Click the Live tab on the tab panel → Select a site to connect 

to from the Site list, and drag and drop it on the Live screen.  
Live video from the selected site is displayed on the screen.  

Refer to Chapter 6 — Live Video Monitoring (p. 45) for 
details. 
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3.4  Playing Recorded Video 
 

 
 

1. Check that the devices were added to a device group in the Site list. 

 
2. Click the Play tab on the tab panel → Select a site to connect 

to from the Site list, and then drag and drop it on the Play 
screen.  Recorded video from the selected site is displayed 

on the screen.  Refer to Chapter 7 — Recorded Video 
Playback & Exportation (p. 67) for details. 
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Chapter 4 — System Overview 
 
 

 
 

① Menu: Refer to Menu (p. 14) for details. 

② Site List: Allows you to connect to the registered site by using the mouse drag and drop.  Refer to Site 
List (p. 15) for details. 

③ Instant Event List: Displays a list of events notified from registered devices.  Clicking the  button 

displays the Emergency Event panel.  Refer to 5.10 Instant Event (p. 38) and Chapter 8 — Event 
Handling (p. 81) for details. 

④ Live Popup List: Displays the list of live popup screens currently displayed on the monitor.  Refer to 

6.4 Controlling Maps, Live Popup (p. 65) for details about the live popup screen. 

⑤ Panel Toolbar/Timetable: Displays the toolbar or timetable depending on the panel.  Refer to 6.3 
Controlling Cameras (p. 55) or Chapter 7— Recorded Video Playback & Exportation (p. 67) for 
details. 

⑥ Panel: Allows you to select which panel to use.  Refer to Panel (p. 16) for details. 
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Menu 
 
System 
 

 

 New Tab: Adds panels. A maximum of 8 panels are supported 
for Live and Play panels altogether and 2 panels for Map panel.  

One of each is supported for Report, Health and Status panels. 

 Remove: Removes selected devices or cameras or all cameras 

from Live or Play screen. 

 Export, Print: Exports or prints images or lists displayed on the 

panel on the selected tab (not supported for all panels). 

 Setup: Allows you to change the basic settings of the REVO 

Remote Pro program.  Refer to Chapter 5 — Setup (p. 17) for 
details. 

 Login, Logout: Logs in or logs out the REVO Remote Pro program. 

 Lock: Locks the REVO Remote Pro program.  When the REVO Remote Pro program is locked, you 
cannot operate the REVO Remote Pro program.  Entering a password releases the lock. 

 Exit: Exits or restarts the REVO Remote Pro program. 
 

View 
 

 

 Save to User Layout: Saves the current screen format. 

 Full Screen: Displays the selected Live or Play panel in full-screen 
format. 

 Full Screen + Toolbar: Displays the selected Live or Play panel in 

full-screen format with a panel toolbar. 

 Reset Floating Tabs: Places all floating tabs on the main tab. 

 Screen Format: Allows you to change the screen format. 

 Show Previous Cameras, Show Next Cameras: Moves to the 

previous or next camera group. 

 Set Hotspot: Sets up a selected camera screen as a hotspot screen.  

Refer to 6.1 Monitoring Video, Hotspot Setup (p. 46) for details. 

 Set Event Spot: Sets up a selected camera screen as an event spot 

screen.  Refer to 6.1 Monitoring Video, Event Spot Setup  
(p. 46) for details. 

 Set Map Event Spot: Sets up a selected camera screen as a map event spot screen.  Refer to 6.1 
Monitoring Video, Map Event Spot Setup (p. 47) for details. 

 Layout Sequence: Starts or stops the layout sequence.  Refer to 6.1 Monitoring Video, Layout 
Sequence Monitoring (p. 50) for details. 

 Emergency Event Panel: Displays the Emergency Event panel.  Refer to Chapter 8 — Event 
Handling (p. 81) for details. 

 Remote Site Panel: Displays or hides a site list in the floating panel or full screen.  Not every panel 
supports this function. 

 Text-In Panel: Displays the text-in panel. It also displays the text results on the panel. 

 Live Freeze: Freezes all screens of the selected live tab. 

 Live Network Monitor: Displays bandwidth for each device on a graph by time. 
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Playback 
 

 

 Play/Pause: Plays or pauses playing recorded video of 
the selected device. 

 Play/Pause on Tab: Plays or pauses playing recorded 
video of all devices displayed on the current screen. 

 Go To: Selects a specific point of video to be played.  

Refer to 7.1 Playing back Recorded Video, Panel 
Toolbar (p. 67) for details. 

 

 Step Playback: Moves the video forward or backward in the frame or time unit. 

 Export Video File: Exports recorded video as a self-player file (.exe) or an AVI file (.avi). 

 Snapshot on Motion: Displays snapshot of images recorded during the event-based recording (event 

and pre-event) in the Play panel.  Refer to 7.1 Playing back Recorded Video, Snapshot on Motion 
Event (p. 72) for details. 

 
About 
 

 

 About: Displays the software version and copyright information. 

 

 

Site List 
 

 

Displays the list of registered sites. 
 

  (Incremental Search): Allows you to search for a registered device or site.  

Entering text that you want to search for causes the search results to be displayed.  

Search results are displayed immediately as matching text is found.  As you enter 

more text, the results narrow. 

 All Devices: Displays the list of devices registered on the REVO Remote Pro 
program.  Clicking a device in the list, and dragging and dropping it in the 

desired location on the screen allows you to monitor video from the cameras 

connected to the device or to play back recorded video from the cameras.  This 

is supported only for the users in the Administrator group. 

 Device Group: Displays the list of registered device groups.  Clicking a device in the list, and dragging 
and dropping it in the desired location on the screen allows you to monitor video from the cameras 

connected to the device or to play back recorded video from the cameras.  Refer to 6.1 Monitoring Video 

(p. 45) or 7.1 Playing back Recorded Video (p. 67) for details. 

 Layout: Displays the list of registered layouts.  Clicking a layout in the list, and dragging and dropping 

it on the screen starts layout monitoring or playback.  Refer to 6.1 Monitoring Video (p. 45) or 7.1 
Playing back Recorded Video (p. 67) for details. 

 Layout Sequence: Displays the list of registered layout sequences.  Clicking a layout sequence in the list, 

and dragging and dropping it on the screen starts layout sequence monitoring.  Refer to 6.1 Monitoring 
Video, Layout Sequence Monitoring (p. 50) for details. 

 Camera Sequence: Displays the list of registered camera sequences.  Clicking a camera sequence in the 

list, and dragging and dropping it in the desired location on the screen starts camera sequence monitoring.  

Refer to 6.1 Monitoring Video, Camera Sequence Monitoring (p. 52) for details. 

 Map: Displays the list of registered maps.  Clicking a map in the list, and dragging and dropping it in 

the desired location on the screen starts map monitoring.  Refer to 6.2 Map Monitoring (p. 54) for details. 
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 HDP: Displays the list of device’s removable/eSATA hard disk drives or SD (SDHC) memory cards 
connected to the REVO Remote Pro system.  A SATA (or IDE) to USB 2.0 Converter is needed to connect 

the removable hard disk drive to the REVO Remote Pro system, an eSATA cable for the eSATA hard 

disk drive and an SD (SDHC) memory card reader for the SD (SDHC) memory card.  Ask your dealer or 

distributor for details.  Clicking the right mouse button in the list displays the storage information (folder 

path, drive type, device model, recording period, storage capacity, etc.). 

 Panic Record: Displays the list of devices if there is any device for which panic recording has been done. 
 

 

Panel 
 

 
 

 Live: Displays live images.  Refer to 6.1 Monitoring Video (p. 45) for details. 

 Play: Allows you to play back video recorded in a device or the REVO Remote Pro system.  Refer to 

Chapter 7— Recorded Video Playback & Exportation (p. 67) for details. 

 Map: Displays maps.  Refer to 6.2 Map Monitoring (p. 54) for details. 

 Report: Displays log entries of the REVO Remote Pro program.  Refer to Chapter 10 — Log 
Search (p. 87) for details. 

 Health: Displays the results of self-diagnostics for the devices in a device group.  Refer to 9.1 Health 
Monitoring (p. 85) for details. 

 Status: Displays the status of a desired device in real-time.  Refer to 9.2 Status Monitoring (p. 86) 

for details. 
 

NOTE: You can change the panel name by clicking the right mouse button on each panel tab. 

 
Adding/Deleting Panel 
 

 

Go to the System menu → Click New Tab → Select a panel to add. 
 

Clicking the  button beside each tab deletes the panel. 

 
Floating/Docking Panel 
 

Clicking a panel tab causes it to fly out and dragging it floats the panel on the screen.  Clicking the tab of 

a floating panel, and dragging and dropping it to its original position docks the panel.  You can change the 

order of panel tabs by dragging and dropping with the mouse. 
 

 Maximizing a floating panel: Clicking the window maximize/restore button in the upper-right corner 
of the floating panel maximizes or restores the window.  Only one of each panel type can be maximized. 

 Displaying/hiding a site list in the floating panel: Clicking the right mouse button in the camera screen 

of the panel and selecting the Remote Site Panel from the screen menu displays or hides a site list in 
the floating panel.  Not every panel supports this function. 
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Chapter 5 — Setup 
 
 

Go to the System menu → Select Setup → Select Device. 
 

  

 

 
 

  Always On Top: Always displays this setup screen in the foreground. 

 

 

5.1  Device 
 

The Device menu allows you to register and manage sites. 
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  (Multiple Firmware Upgrade): Allows you to upgrade software for several devices at the same time.  

Refer to Managing Devices, Upgrading Device’s Software (p. 22) for details. 

  (Multiple Remote Setup): Allows you to change settings of several devices at the same time using a 

setup file.  Refer to Managing Devices, Changing Device’s Setting Remotely (p. 22) for details. 

  (Network Keyboard Setup): Allows you to add, remove and edit a network keyboard.  You can control 

the REVO Remote Pro program with a network keyboard.  Refer to Chapter 12— Controlling With 
a Network Keyboard (p. 95) for details. 

 Site (Site Panel): Displays site group lists supported by the REVO Remote Pro program.  See Site (p. 18) 

for details. 

 Name, Group, Address, Type, Description (Site List Panel): Displays the list and information about sites 
registered in each group. Clicking the arrow button ( ) beside each device name displays information 

of video in, alarm in/out and audio in/out supported by the device. 

  (Incremental Search): Allows you to search for a device or site registered in each group.  

Selecting a group in the Site panel and entering text that you want to search for causes the search results 
to be displayed.  Search results are displayed immediately as matching text is found within the selected 

group.  As you enter more text, the results narrow. 

  (Add),  (Remove),  (Edit): Allow you to add, remove and edit a device or a site.  You can also 
delete sites from the group or to edit registration information by using the menu that is displayed when 

selecting a site and clicking the right mouse button.  If you select a device, you can connect to it and 

change its settings or upgrade its software remotely.  If you delete a device from All Devices and register 
the device again, the REVO Remote Pro system considers the device as a new device.  Refer to 

Managing Devices (p. 19) for details about registering a device or device group, or Chapter 6 — 
Live Video Monitoring (p. 45) for details about registering a layout or sequence. 

 
NOTE: In this manual, a “site” refers to a device group, layout or sequence registered on the REVO Remote 
Pro program. 

 
Site 
 

 All Devices: Displays devices registered in the REVO Remote Pro program.  Refer to 3.2 Registering 
Devices (p. 7) for details about registering devices. 

 Device Group: Displays registered device groups.  You can monitor or play back recorded video from 
the cameras in device groups.  You must register devices in the REVO Remote Pro program and add 

the devices to a device group to perform any operation.  Refer to 3.2 Registering Devices (p. 7) for 
details about registering device groups. 

 Layout: Displays the registered layouts.  You can monitor video from multiple cameras in a predefined 

layout.  Refer to 6.1 Monitoring Video, Layout Monitoring (p. 47) for details. 

 Layout Sequence: Displays the registered layout sequences.  You can monitor video from multiple 

cameras sequentially in more than one predefined layout.  Refer to 6.1 Monitoring Video, Layout 
Sequence Monitoring (p. 50) for details. 

 Camera Sequence: Displays the registered camera sequences.  You can monitor video from multiple 

cameras sequentially in the same camera screen.  Refer to 6.1 Monitoring Video, Camera Sequence 
Monitoring (p. 52) for details. 

 Map: Displays the registered maps.  You can monitor video from cameras, event detection and input/output 

device’s status on a map.  Refer to 6.2 Map Monitoring (p. 54) for details. 
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Managing Devices 
 
You can edit or delete the device from a list.  You can also connect to a device to change its settings or upgrade 

its software remotely.  Go to the System menu → Select Setup → Select Device. 
 

Click a device group in the Site panel and then click a device in the Site List panel.  Clicking the  button 
at the bottom of the Site List panel, or clicking the right mouse button displays the device menu. 
 
 

 

 

OR 

 
 

 Edit Device: Allows you to change information for connecting to the device.  Refer to Editing Device 
Information (p. 20) for details. 

 Remote Setup Device: Allows you to change the device’s settings remotely.  Refer to Changing 
Device’s Setting Remotely (p. 22) for details. 

 Firmware Upgrade: Allows you to upgrade the device’s software remotely.  Refer to Upgrading 
Device’s Software (p. 22) for details. 

 Remote Desktop: Allows you to connect to the device using the VNC (Virtual Network Computing) 
function.  For this feature to work, the VNC function must be enabled in the device and a port number 

and password for the VNC remote connection must be registered during the device registration at 

REVO Remote Pro program.  Refer to Editing Device Information, Remote Desktop (p. 21) for 
details about registering the port number and password for the VNC remote connection at REVO 

Remote Pro program.  This function may not be supported, depending on the specifications and version 

of the device. 

 Clone Device: Allows you to clone the registered device.  Refer to Clone Device (p. 23) for details.  
Device information is cloned identically when cloning the device.  You can change the device information 

by selecting Edit Device from the device menu of the cloned device.  The device’s authentication 
procedure, which is entering the user ID and password of the device, is not required when changing the 

device information.  A clone icon ( ) is displayed at the device icon in the device list to distinguish 

the cloned device. 

 Update Device Information: Displays the newest information of the selected device. 

 Preview Video: Allows you to preview the device’s video. 

 Remove Device: Deletes the device from the REVO Remote Pro program. 
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Editing Device Information 
 

Select Edit Device from the device menu. 
 

Information 
 

 

This allows you to change information of the device. 

 Name: Edit the device name.  You can use the same 
name for more than one device. 

−  Disable Device: The REVO Remote Pro 
program no longer considers the device registered 

in the REVO Remote Pro program. 

−  Device Name Sync: Automatically applies 
the name set in the device to the REVO Remote 

Pro program. 

−  Device Real-Time Monitoring: The REVO 
Remote Pro program updates the device’s event 

information and device information automatically 

for all registered devices.  The connection to a 

device may not be available depending on the 

maximum number of simultaneous connections to 
the device when several REVO Remote Pro 

systems try to connect to the device simultaneously.  

If this option is disabled, the REVO Remote Pro 

program updates the information only for the 

devices that are currently being monitored. 

−  Device Low Bandwidth Communication: 
The client operates according to the low 

bandwidth environment. 

 Group: Displays the list of device groups and 
services that the device is registered on. 

 Device Type: Displays the device type. 
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Network 
 

 

This allows you to change information for 

connection to the device.  The device’s 
authentication procedure, which is entering the user ID 

and password of the device, is required. 

 Address Type: Select device’s address type. 

− Auto Scan (LAN): Allows you to enter the device’s 
mDNS number when you edit the device’s address. 

− IP Address: Allows you to enter the device’s IP 
address when you edit the device’s address. 

− DVRNS: If the device uses the DVRNS (DVR 
Name Service) function, this allows you to enter 

the device name which is registered on the 
DVRNS server when you edit the device’s 

address.  The name should match the one set 

during the DVRNS setup in the device. 

− Domain Name: If the device uses the domain 
name service, this allows you to enter the device’s 

domain name registered on a DNS server when 

you edit the device’s address. 
 

 Address: Edit the device’s address based on the selected address type above. 

 Port: Edit the port numbers.  The port numbers you enter should match the port numbers set in the device 

for remote connection (Admin), remote monitoring (Watch), recording (Record) and two-way audio 

communication (Audio). 

 ID, Password, Connection Test: The device’s authentication procedure is required to change the 

information above.  Enter the user ID and password of the device and click the Connection Test button.  

When the connection test succeeds, you can click the OK button to apply the changes. 

 Password Reissue: Reissue the remote device password.  Refer to Device Password Reissue (p. 

27) for details. (Only for the products that support this function.) 

 

Remote Desktop 
 

 

This allows you to register a port number and 

password for the VNC (Virtual Network Computing) 

remote connection. 
 

 Port, Password: Enter a port number and password 
set in the device for VNC remote connection. 

  Scale to window size: Scales the VNC Viewer 
screen to fit window size. 

  Auto Reconnect: Reconnects automatically 
when the VNC remote connection is released. 

  Enable Toolbar: Enables the toolbar of the 

VNC Viewer. 
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Changing Device’s Setting Remotely 
 

Selecting Remote Setup Device from the device menu allows you to change the device’s settings remotely.  
Changing the device’s settings remotely might not be available for some settings.  Refer to the device’s 

user manual for details about the settings. 
 

You can change settings of several devices at the same time using a setup file.  Clicking the  (Multiple 

Remote Setup) button above the Site panel displays the following screen. 
 

 

Click the  button at the top right corner and 

select a setup file.  The list of available devices 

is displayed.  This function might not be 

supported depending on the device model, and 

the devices that this function is not supported 
for will not be displayed in the list even if the 

setup file is available for the devices.  Select 

devices and click the Apply button at the bottom 
to apply the change. 

 
Upgrading Device’s Software 
 

If you have an upgrade file, selecting Firmware Upgrade from the device menu allows you to upgrade 
the device’s software remotely. 
 

You can upgrade software of several devices at the same time.  Clicking the  (Multiple Firmware Upgrade) 
button above the Site panel displays the following screen. 
 

 

Click the  button at the top right corner and 

select an upgrade file.  If the device is a 

PC-based DVR, check the PC Based DVR 
box and click the  button.  The list of 

available devices is displayed.  Selecting Show 
all devices displays all registered devices.  

Select devices and click the Upgrade button 
at the bottom to start upgrading. 

 



REVO Remote Pro (Remote Administration System) 

 
 

23 

Clone Device 
 

 

The cloned device is listed in the left side.  Select a device 

group in the right side to add the cloned device to the 
selected device group. 

 
Editing Input/Output Device Information 
 

Click All Devices in the Site panel and then the arrow button ( ) beside each device name in the Site 
List panel.  Click the input/output device in the list of video in, alarm in/out and audio in/out supported by 

the device.  Clicking the  button at the bottom of the Site List panel, or clicking the right mouse button 

and selecting Edit Device from the menu displays the Edit Device window. 
 

 

 

OR 
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 Device Name: Edit the name of the input/output device.  You 
can use the same name for more than one input/output device.  

The name will be updated automatically when the name of the 

device to which the input/output device is connected is updated. 

 Associated Audio Channel: Select the audio channel to associate 
with the camera for audio recording (supported only for a camera).  

The selected audio channel will be recorded when video from 

the camera is recorded. 

 Associated Device: Select a camera channel to associate with 
the alarm-in or audio-in device for display on the event spot screen 

(supported only for an alarm in or audio-in device).  Video from 

the selected camera channel will be displayed on the event spot 

screen when an alarm-in or audio-in event is detected. 

 

Device Password Reissue 
 

Reissue the remote device password.  This function is only for the products that support the device password 

reissue function. 

 

Device Password Initialization 
 
1. When registering a device, the User Authentication window pops up to ask whether to reset the password 

in the case of the devices that need the password initialization.  For the device that needs the password 
initialization, device registration is enabled after the initialization.  Click Yes to display the password 
initialization window. 

 

 
 

2. Enter the information for the initialization and click OK to reset the device password.  
 

 

 
 

 

 

 New Password/Confirm Password: Enter the new password. 
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 Phone Number: Enter the phone number that allows SMS for receiving the One Time 
Password(OTP) when resetting the password. 

 Email: Enter the email address for receiving the One Time Password(OTP) when resetting the 
password. 

 

Changing Device Password 
 

Select Edit Device from the device menu, and click Password Reissue on the Network tab. 
 

 
 

1. Select an authentication method and enter the email address or phone number.  Click Authentication 
and enter the new password. 

 

  

 
 

 

 

 
2. Enter the new password and click OK. 
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 New Password/Confirm Password: Enter the new password. 

 
3. Click the Connection Test button from the Edit Device window to check the user authentication with 

the reissued password. 
 

 

 

 
Click OK when the connection test is complete. 
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Device Password Reissue 
 

The password reissuance works only when the customer service connection is available, since One Time 
Password (OTP) is issued through the customer service.  Ask your dealer or retailer for more information. 

 
1. If the user authentication fails (password error) during the device registration, the window pops up to 

check whether to reissue the password or not. 
 

 
 

2. Click Request to reissue the password. 
 

  
 

 ID: Enter the user ID that requests the password reissuance. 
 Authentication Method: Select an authentication method between the email address/phone number. 
 Email Address/Phone Number: Enter the email address or phone number that allows SMS for 

receiving the One Time Password(OTP) when resetting the password. 
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5.2  User 
 

The User menu allows you to register and manage users or user groups. 

 

 
 

 Group (Group Panel): Displays a user group list.  The Administrators group has authority to perform 
all functions, and the authority settings cannot be edited. 

 Name, ID, Email, Phone, Description (User List Panel): Displays the list and information about users 

registered in each group. 

  (Incremental Search): Allows you to search for a user registered in each group.  Selecting 

a group in the Group Panel and entering text that you want to search for causes the search results to be 
displayed.  Search results are displayed immediately as matching text is found within the selected group.  

As you enter more text, the results narrow. 

  (Add),  (Remove),  (Edit): Allow you to add, remove and edit a user group or user. 
 

 

User Management 
 

You can assign every user different authority levels for each function of the REVO Remote Pro program.  The 

Administrators group has authority for all functions, and the authority settings are not editable. 
 

1. Click the  button at the bottom of the user group list.  The Add User Group window appears. 
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 Information tab: Enters the user group name. 

 Device Access Authority tab: Grants or limits authority for the access to each device. 

 Authority tab: Grants or limits authority for each function. 
 

Clicking the OK button completes registration of the user group. 
 

2. Click the added user group in the Group list, and then the  button at the bottom of the user list.  The 

Add User window appears. 
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  Disable: Check the box to disable the user. 

 Name: Enter the user name. 

 ID, Password, Confirm: Enter a unique user ID and password (8 to 16 characters without spaces) for 
access to the REVO Remote Pro program. 

  No Password: Allows you to log in without a password when running the REVO Remote Pro 

program. 

  Password Expiration Setup: Set the password expiration period.  If the password has not been 

changed during the password expiration period, you will be informed of it when you log on. 

 User Specific Layout: Select the user layout when running the REVO Remote Pro program. 

 E-Mail: Enter the email address of the user.  An email address must include the “@” character to be a 

valid address. 

 Phone, Description: Enter the telephone number and description of the user if you want.  Only numbers 

and “–” are allowed when entering a telephone number. 
 

Click the OK button at the bottom. 
 

3. Clicking the registered user group or a user in the list, and then the  button at the bottom allows you 

to edit the information. 

4. Display all registered users in the REVO Remote Pro system regardless of the user group if you select 

All UserGroup. 
5. Click the registered user in the list, and then drag and drop it in the other user group to change the 

group.  Monitoring group is also changed when changing the user group. 

 

 

5.3  Panic Record 
 

This allows you to start or stop recording manually while monitoring video. 

 
NOTE: Panic record is available only when video is currently displayed on the Live tab.  For example, if you 
change the screen format during panic record and monitoring video is hidden on the Live tab, panic record 
will stop for the hidden video. 
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 Total Space: Displays the total and remaining capacity of storage allocated for panic record. 

 Recorded Time: Displays the record period. 

 Overwrite: Displays whether overwrite mode is enabled or disabled.  When overwrite mode is enabled, 

the REVO Remote Pro system records over the oldest video data once all available storage space has 

been used.  When overwrite mode is disabled, the REVO Remote Pro system stops recording once all 

available storage space has been used. 

 Clear All Recorded Data: Deletes all recorded data in the REVO Remote Pro system. 

 Reconstruct Abnormal Recorded Timetable: When any error occurs during recording, the recorded 
data and the timetable information of the recorded data might not match and the timetable in the 

REVO Remote Pro program might display incorrect information.  In this situation, clicking the button 

reconstructs the timetable to display recorded data correctly on the timetable in the REVO Remote Pro 

program. 

  Overwrite recorded data when the disk is full: Records over the oldest video data once all available 
storage space has been used. 

 Use Panic Recording: Enables panic recording. 

− Storage Path: Allows you to set up the storage folder path for panic recording. 

− Capacity: Sets up the storage capacity to be allocated to the hard disk drive (Min. 4GB to max. 64GB). 
 
You can do panic recording as follows: 

 

Select the camera screen (on the Live screen) that displays the video you want 

to record and click the  (Panic Recording) button on the control toolbar.  The 

Panic Recording icon ( ) will be displayed at the top right corner of the camera 

screen when the system starts recording.  Click the  (Panic Recording) button 

again to stop recording. 
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5.4  System 
 

 
 

 Language: Select the language in which the REVO Remote Pro program will run.  The change will be 
applied the next time the program is run. 

  Reset Tab Name: This option is displayed when a language different from the current language is 
selected. When restarting the system after selecting this option, every tab name is reset to the selected 

language including the name entered by the user. 

  Device Real-Time Monitoring: Select the range of the Device Real-time Monitoring.  This setting 

changes the real-time monitoring status of the devices.  If All Devices Deactivated is selected, the 

Device Real-time Monitoring is removed from the Edit Device window of each device.  

  Disable display scaling on high DPI settings: Uncheck to change the size of the client program 
according to the DPI scale. 

  Auto run REVO Remote Pro at Windows startup: The REVO Remote Pro program 
automatically runs when logging into Windows. 

  Pop up login notification: A message box will pop up notifying login when logging into the 

REVO Remote Pro program. 

  Load user specific layout: Displays the user layout in which the REVO Remote Pro program will 

run.  

  Startup Full Screen: Displays the full screen in which the REVO Remote Pro program will run.  
Clicking Setup can select the panel that displays the full screen on each monitor. 

 CPU Usage Popup: An alert message will pop up when the CPU usage of the REVO Remote Pro 

system exceeds the assigned percentage. 

 Number of Processors to use: Set up the number of processors to use during the REVO Remote Pro 
program running.  It allows you to limit the CPU usage for the REVO Remote Pro program running. 

  Auto login at startup: The REVO Remote Pro program automatically logs in with the login 

information from the previous connection when it starts.  Checking the Restore last Live sessions 
at auto login box restores the previous live monitoring sessions in the current Live panels. 
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  Auto: The REVO Remote Pro program automatically logs out or the REVO Remote Pro system is 
locked out depending on the setting when there are no mouse or keyboard inputs for the specified time. 

 Date/Time: Displays the current date and time. 

 Date Format, Time Format: Set up the system date/time format. 

 Start Week On: Set up the day of the week to start. 
 

 

5.5  Screen Format 
 

 
 

 Side Pane Position, Map Sitemap Position, Text-In Pane Position: Set up the position of side 
panels and the position of the root map list in the Map panel, and the position of text-in panels. 

 Live Default, Playback Default, Map Default: The default screen formats for the Live, Play and Map 

screens are displayed.  Clicking the Format Setup button allows you to change the default screen format. 

  Change the screen format based on the selected camera: Displays video from a camera selected 

from the current screen format in the first camera screen of the new screen format when you change 

screen formats. 

  Format expansion automatically: The screen format changes automatically corresponding the 
number of connected camera when the number of connected camera increases. 

 

 



User’s Manual 

 
 

34 

5.6  Screen Display 
 

 
 

 Display OSD: Sets up the OSD display setting and information to be displayed on a camera screen. 

− Opacity: The slide bar allows you to adjust the opacity of OSD (On Screen Display).  

−  Selected Pane No Border: Does not display a border on a currently selected camera screen during 
monitoring or playback. 

−  Selected Pane Title Bar Only: Displays the title bar on a currently selected camera screen during 
monitoring or playback. 

− Live, Playback: Sets up OSD information to be displayed. 

  Camera Title: Displays the camera name set in the REVO Remote Pro program. 

  Title Bar: Separates the title display area from an image display area at the top. 

  Recorded Title: Displays the camera name which was set up during recording. 

  Status Icon: Displays status OSD. 
 

 (Orange): During Panic Recording : In the PTZ mode : In the zoom mode 

: During camera sequencing : Listen : Talk 
: When the color control function is used (playback video only) 
: When the image effect function is used 
: When images on the screen is frozen by a network keyboard (live images only) : Recording 

 

  PTZ: Displays direction control buttons which is displayed on the camera screen when 
controlling a PTZ camera. 

  Event Alert, Event Alert Dwell Time: Highlights the camera title bar in red when an event 
occurs in the device.  The alert will release after the event dwell time (sec.) from the time an event is 

detected or when you select the camera screen if you set up the Event Alert Dwell Time setting to 

Manual Off. 
  Motion Block: Displays the area where motion is detected with red blocks when a motion detection 

event occurs in the device (supported only for network video transmitters). 

  ePTZ: Displays the guide GUI (Graphic User Interface) when you control PTZ in the fisheye 

camera. 

  Site Name: Displays the device name.  This will be displayed only when the device name is 

different from the camera title. 



REVO Remote Pro (Remote Administration System) 

 
 

35 

  Face Detection: Displays the area whether face is detected with blocks when a face detection 
event occurs in the device. 

  Video Analysis Device: Displays the real-time video analysis (VA Box) data. 

  Text-In, Text-In Dwell Time: Displays the text-in information on the screen when a text-in event 
occurs in the device (1x1 screen format only).  The Text-In information will be removed after the 

Text-In Dwell Time from the time an event occurred. 

  Message: Displays a screen message.  Refer to 5.11 Network (p.39 ) for details about the screen 
message. 

− Position: Allows you to change the position of the OSD, OSD text size and OSD margin. 

− Text-In: Allows to change the color and size of the text-in. 

 Control Toolbar: Adjusts the opacity of the control toolbar on the camera screen. 

 

    
Camera Title,  

Status Icon, Date/Time 
Event Alert Motion Block Control Toolbar 

−  Popup on the Hover Zone: Toggles on/off the toolbar by a mouse cursor position in the hover 

zone. 
 

 

5.7  Screen Menu 
 

 
 

 Context Menu: Adds or removes the context menu items on the live tab. 

  Remove disabled menu items: Removes the disabled menu items from the context menu. 
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5.8  Video Enhancement 
 

 
 

 Aspect Ratio: Select the proper image aspect ratio. 

− Original Ratio: Fits images within the screen size while maintaining their original ratio. 

− Fit to Screen: Fits images to the screen size regardless of the aspect ratio. 

− Fit to Screen (Smart): Fits images according to the extra spaces, to the “Fit to Screen” or “Actual 

Size”. 

− Fit to Screen (Aspect Ratio): Fits images to the screen size keeping the aspect ratio.  This might cause 

top and bottom or left and right side of images to be cropped depending on the screen size.  This aspect 

ratio is not supported and Original Ratio is applied for camera screens that the following functions are 
activated: Image Zoom, Hotspot, Event Spot, Draw Motion Block. 

− Actual Size (x1): Displays images in their original size. 

 Drawing Mode: Select the drawing mode standard to display video on the screen.  The color quality or 

display performance of video might be affected depending on the drawing mode standard selected. 

  Deinterlacing: Enhances image display quality of interlaced video on the screen by eliminating 
horizontal scan lines or noise in areas with motion.  Select the desired deinterlace filter. 

  Anti-Aliasing: Enhances image display quality of video on the screen by eliminating stair-stepping 
(aliasing) effects in the enlarged image. 

  Important Video Performance: Gives priority to display speed over the display quality on the 

screen when displaying video. 

  High-Quality Downscaling/Upscaling: Keeps the display quality on the screen when 
downscaling/upscaling video. 

  Trim The Black (noise) Edges: Trims the black line (noise) displayed at the edge of the image. 

  Improve Tearing Artifacts: Improves tearing artifact caused when the monitor’s scanning line retracing 

speed is slow (1x1 screen format only).  This might increase the CPU load. 

  Disable Transparent Window: Disables using a transparent window style and opacifies windows 
including the control toolbar to correct the problem of transparent areas of the window flickering.  The 

change will be applied the next time the program is run. 

  Disable Desktop Window Manager (DWM): Disables Desktop Window Manager (DWM) that runs 
Windows Aero.  Disabling DWM is recommended if video often freezes when multiple monitors are used. 
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  Dynamic Multistream Control: Allows you to use a different stream depending on the screen format 

(supported only for devices in which more than one stream is used).  Selecting Auto allows the REVO 
Remote Pro program automatically to choose the proper stream based on the screen format. 

  Interactive Bandwidth Control: Controls the network bandwidth by automatically adjusting the 

resolution and the frame rate of the device depending on a screen format (1x1 screen format: the maximum 

resolution and frame rate supported by the device, Multi-screen format: the resolution and frame rate 
decreased to an appropriate level for each screen format).  This function enhances the network bandwidth 

efficiency and decreases a drop in performance of the REVO Remote Pro system which might be caused by 

the network congestion.  For this function to work, the device must be also set up to use the function.  

This function works only for monitoring video. 

  Use H/W Acceleration – iGPU: Enables hardware acceleration in the REVO Remote Pro program.  It 
may enhance processing of HD (high-definition) video.  This option is available only when hardware 

acceleration is enabled in your PC. 

  Use GPU Decoding – DXVA2: Enables GPU decoding in the REVO Remote Pro program.  It may 

enhance processing of HD (high-definition) video.  This option is available only when GPU decoding is 

enabled in your PC. 

 

 

5.9  Report 
 

 
 

 Number of results displayed on the list: Set up the number of log entries to be displayed at once (in 

the case of Device Log, maximum 100 logs at once regardless of the setting). 

  Update Interval: Set up the status update interval in the Health panel. Select Not Use to disable 

the Health panel. 

  Connection Retry Count: Set up the maximum number of connection retries. 

  Status Request Timeout: Set up the maximum waiting time for device status request. 

  Save problem status as: Save the log of the selected problem items as PDF or CSV according to 
the update interval.  Set up the storage folder with a title and password (PDF only). 
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  Popup problem status notification: Display a popup notification when a problem occurs from the 
selected problem items according to the update interval. The popup notification displays issue related 

information, and click Self-Diagnosis to start the self-diagnosis. 

 Popup Timeout: Set the time for automatic closing of the problem status popup window. Select 

Infinite for a user to manually close the popup. 

 

 

5.10  Instant Event 
 

 
 

  Use Event Panel: Displays the Instant Event List panel.  Unchecking the box hides the panel. 

 Time Range: Set up the length of time for an event notification to be displayed in the Instant Event 

List after notification of the event detection (If the event list has 100 or fewer items, the event list will 
remain on the Instant Event List even if the length of time has expired). 

 Column: Select the information to be displayed in Instant Event List. 

 Callback Port: Set up the port number to receive a callback message from the device.  The port number 
you enter should match the port number set on the device for remote callback. 

 Live Text-In Time Range: Set up the length of time for a text-in data to be displayed when a text-in 
event occurs.  You can check the text-in data in the text-in viewer window within the time range since 

the text-in event occurred.  Refer to 6.3 Controlling Cameras, Text-In Viewer (p. 62) for details about 
the text-in viewer window. 

 Event Sound: Set up to sound by playing back an audio file when an event is notified in the Instant 

Event list.  Select a desired event and set up an audio file (.wav) by clicking the  button.  Clicking 

the  button allows you to test the sound by playing back the selected audio file. 

−  Auto disable when Two-way Audio is on.: Set up to automatically turn off the event sound when 

using the two-way audio. 



REVO Remote Pro (Remote Administration System) 

 
 

39 

 Event Spot: Video from the event-detected camera is displayed on the event spot screen when an event 
is notified in the Instant Event list. 

− Event monitoring dwell: Set up the duration for video to be displayed on the event spot screen. 

− Minimum monitoring dwell: Set up the event monitoring dwell time for the current event when other 
events are detected while event-detected video is displayed.  Video from other events is displayed after 

the preset time expires. 

 

5.11  Network 
 

 
 

  Buffering for HD Live: Displays images on the screen more smoothly by using short term/long term 
buffering when monitoring HD video images.  Buffering may be delayed or real-time monitoring may 

decrease depending on the network environment. 

 Live image no frames detect interval: Set up the interval to check video frame transfer from a device 

to the REVO Remote Pro system.  A message will be displayed on the camera screen when no video frame 

is transferred during the period. 

 Disconnection Message: Allows you to change the text of the screen message displayed when a device 

is disconnected or when you connect to the device.  Click the Setup button, check the box beside each 
message and change the text. 

 DVRNS: Allows you to enable the DVRNS (DVR Name Service) function and enter information of 
the DVRNS server on which a device is registered if there is a device that uses DVRNS function.  If 

this setting is not correct, registration of the device and connection to the device will not be made.  When 

the DVRNS function works, it might not be supported to connect to the device using the VNC (Virtual 

Network Computing) function, depending on the network connection type (e.g., UDP Hole Punching, 

Relay) of the device and REVO Remote Pro system. 

 RTP Incoming Port Range: Set up the port range if a device which transmits images using the RTP 
protocol is registered.  Port range settings must be changed if the network firewall or local network allows 

only specific UDP/RTP port numbers.  The port numbers should not conflict with the RTP port numbers 

of other streaming programs.  If an RTP port number conflicts with others, monitoring may not be available. 
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 Don’t display broken frames: It is possible that frames will be broken or lost when using the RTP protocol 
depending on the network environment.  Select whether or not to display the broken frames in Live or 

Play panels. 

 Buffering Frame Count: Set up the number of buffering frames to use for the RTP protocol.  The higher 
the number is, the less the video stutter.  The lower the number is, the higher the real-time monitoring. 

  Use Network Keyboard: Allows you to control the REVO Remote Pro program by using a 

network keyboard.  Set up the port number that the REVO Remote Pro program will use when it is 

controlled by a network keyboard.  Selecting Use large mouse cursor enlarges the mouse cursor 
size. 

 

 

5.12  Playback 
 

 
 

 Event Time Shift: Set up to search the frame before the specific time based on the event-related frame 
time. 

 Dual-Stream Playback Priority: Set up to select the default stream for the dual-stream playback. 
Playback is performed from the 2x2 layout for Dynamic Control, from layouts under 2x2 for Main 
Stream Priority, and from the other layouts for Sub Stream Priority. 

  Prefer Responsiveness to Time-Precision: Displays the closest time frame possible while reducing 
the loss of responsiveness, preferred than time-precision, when performing the GoTo function on a 
Long-GOP image.  

   Key-Frame mode forced on Long-GOP backward playback: Set up to play the key-frame only 
on Long-GOP backward playback. 
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5.13  Site 
 

 
 

  Expand Device Groups: Unfolds a device group to display the list of devices added to the device 
group in the Site list when monitoring video or playing back recorded video. 

  Show Disabled Devices: Displays or hides the disabled devices in the Site list. 

 Show Device Real-Time Monitoring: Set up the way of displaying device real-time monitoring (Not 

use, Icon , Green overlay ) on the site tree. 

 Item: Displays or hides a list of input/output devices supported by the device in the Site list when 
monitoring video or playing back recorded video. 
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5.14  Map 
 

 
 

  Use Live Popup Panel: Displays the Live Popup List panel.  Unchecking the box hides the panel. 

  Use Event Sound Multiple Play: Simultaneously plays each camera’s sound file when events occur 

at multiple camera sites at the same time.  Uncheck the box to play the first event’s sound file. 

  Activate Auto Focusing: Enlarges the area where the event-detected device is placed when an event 
is detected. 

− Focusing Event: Select a desired event for auto focusing. 

− Focusing Duration: Set up the duration for auto focusing to last. 

− Focusing Minimum Dwell: Set up the duration for auto focus to last for the first detected event when 
events are detected in more than one device consecutively.  Auto focusing moves to the later detected 

event after the preset time expires. 

 Zoom Finder: Displays or hides the PIP screen.  The rectangle in the PIP screen indicates the enlarged 

area.  When set to Auto, the PIP screen is displayed only while a canvas is enlarged. 

 Map Event Spot: Video from the event-detected camera is displayed on the map event spot screen when 
an event is detected. 

− Event monitoring dwell: Set up the duration for video to be displayed on the map event spot screen. 

− Minimum monitoring dwell: Set up the event monitoring dwell time for the current event when other 

events are detected while event-detected video is displayed.  Video from other events is displayed after 

the preset time expires. 

 Instant Viewer: Set up the duration for the instant view to be displayed.  Instant Viewer is displayed 

when clicking a camera on a map. 
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5.15  Action 
 

 
 

 General: Set the general action on the live popup. 

−  Use Ctrl+Popup Pane Drag: Press Ctrl button and drag the live popup to a pane on the Live tab to 

display the image on the pane. 

−  Enable PTZ Automatically: Set PTZ control function automatically. 

 Live Popup: Double-click on the pane to practice the following functions. 

− Maximize or Restore  

− 1x1 Pane on Live Screen 

− Maximize on Application Monitor 

 Instant Viewer: Double-click on the predefined button, the middle or the right button, of the mouse to 

perform the following functions. 

− 1x1 Pane on Live Screen 

−  Turn (e)PTZ Functions On: Set PTZ control function on default. 

−  Disable Time Out: Disables the popup dwell time out after Action. 

 Fisheye: Set up the default Action when accessing a fisheye camera. 

− Startup Preset: Set up the preset name to be used when accessing a fisheye camera.  If each camera’s 

format is saved under the same preset name, it is easier to change the format. 

− Default View Mode: Set the default view mode. 

− Image Ratio: Set the image ratio. 

− ePTZ Frame Rate: Set the ePTZ frame rate.  High (Over average of 60 Fps), Normal (Over average 

of 30 Fps), Low (Average of 15 Fps), Very Low (Average of 5 Fps) – a PC with a low specification is 

appropriate. 

− Auto Pan Frame Rate: Set the auto pan frame rate.  High (Over average of 60 Fps), Normal (Over 

average of 30 Fps), Low (Average of 15 Fps), Very Low (Average of 5 Fps) – a PC with a low 

specification is appropriate. 

−  Use ePTZ: Uses ePTZ when accessing a fisheye camera. 
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5.16  Save 
 

 
 

 Folder: Select a folder to save the still image. 

 Filename: Set a name of the folder for saving the still image.  Supported extensions include JPG, PNG, 

TIF, BMP and PDF. 

−  Include Image Information: Include image information in the saved still image file. 
 
 

5.17  Backup/Restore 
 

It allows you to save the setting values of the REVO Remote Pro program as an .iexp file or to apply the 
saved setting values to the current REVO Remote Pro program. 
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Chapter 6 — Live Video Monitoring 
 
 

You can monitor live video of each group.  The REVO Remote Pro system displays video from devices 

based on the settings in the device on the Live screen. 

 

 

6.1  Monitoring Video 
 

Live video monitoring is supported in the Live panel (maximum 4).  If the Live tab is not on the tab panel, 

go to the System menu, click New Tab, and then Live. 
 

 

 

 

Click the Live tab on the tab panel → Select a site to connect 

from the Site list, and drag and drop it on the Live screen.  
Live video from the selected site is displayed on the screen.  
You can move a camera screen to the desired location on the 

Live screen without disconnecting the current connection 

while monitoring video.  Select a camera screen and drag and 

drop it on the desired location. 

 
 
NOTE: The REVO Remote Pro system performance might deteriorate when simultaneously monitoring or 
playing back multiple videos on a PC with a low specification. 

 
Panel Toolbar 
 

The panel toolbar at the bottom allows you to control the Live panel. 

 

 
 

  (Save to User Layout): Saves the current screen format. 

  (Screen Format): Changes the screen format.  Clicking the  button 

displays more available screen formats.  Clicking the  or  button moves to the previous or next camera 

groups. 

  (Hotspot): Sets up a selected camera screen as a hotspot screen.  Refer to Hotspot Setup (p. 46) for 

details. 

  (Event Spot): Sets up a selected camera screen as an event spot screen.  Refer to Event Spot Setup 
(p. 46) for details. 
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  (Map Event Spot): Sets up a selected camera screen as a map event spot screen.  Refer to Map Event 
Spot Setup (p. 47) for details. 

  (Layout Sequence): Starts or stops layout sequence.  Refer to Layout Sequence Monitoring (p. 50) 

for details. 

  (Additional Panel) 

− Remote Site Panel: Displays or hides a site list in the floating panel or full screen.  Not every panel 
supports this function. 

− Text-In Panel: Displays the Text-In panel. 

  (Export Video File) 

− Save Still Image: Saves the current image on the screen as an image file at its original size. 

− Export Image File, Print Image: Exports or prints the images currently displayed on the screen. 

− Export Panorama Screen: Exports the images currently displayed on the screens and the floating 
panels. 

  (Audio Broadcast): Broadcasts audio to all devices in the current Live tab. 

  (NVR Two-Way Audio): Receives audio from the NVR device or sends audio to the NVR device. 

  (Panic Recording): Performs panic record for all video in the current Live tab.  

  (Text-In Panel): Displays the Text-In panel.  The Text-In panel shows the text-in data of devices 
currently connected to the REVO Remote Pro system.  If a camera is associated with the text-in device and 

video of the associated camera is displayed on the current Live screen, the text-in data is displayed 

overlapping video on the camera screen, too.  You can change the length of time for the text-in data to be 

displayed at the Live Text-In Time Range setting.  Refer to 5.10 Instant Event (p. 38) for details 

about the Live Text-In Time Range setting. 
 
Hotspot Setup 
 
NOTE: The “hotspot” in the REVO Remote Pro program is a predefined camera screen in which video 
from any camera among those currently displayed can be monitored with emphasis.  The hotspot screen is 
surrounded by a red outline. 

 

1. Select a camera screen to set up as a hotspot screen on the current monitoring screen. 

2. Click the  (Hotspot) button on the toolbar at the bottom of the Live panel, and the current connection 
in the selected camera screen is released.  The hotspot screen is surrounded by a red outline. 

3. Select any camera on the screen.  Video from the selected camera is displayed on the hotspot screen, and 

you can control the camera. 
 

 

 

 
 

 

 

 

 

 

 
 
Event Spot Setup 
 
NOTE: The “event spot” in the REVO Remote Pro program is a predefined camera screen in which video 
from a camera which an event is detected among cameras currently displayed can be monitored with 
emphasis.  The event spot screen is surrounded by a blue outline. 
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1. Select a camera screen to set up as an event spot screen on the current monitoring screen. 

2. Click the  (Event Spot) button on the toolbar at the bottom of the Live panel, and the current connection 

in the selected camera screen is released.  The event spot screen is surrounded by a blue outline. 
3. When an event is detected, video from the event-detected is displayed on the event spot screen. 
 

 

 

 
 

 

 

 

 

 
CAM3: 

An event is detected.  

 
 

Map Event Spot Setup 
 
NOTE: The “map event spot” in the REVO Remote Pro program is a predefined camera screen in which video 
from a camera which an event is detected among cameras on a map can be monitored with emphasis.  The 
map event spot screen is surrounded by a gray outline. 

 

1. Select a camera screen to set up as a map event spot screen on the current monitoring screen. 
2. Click the  (Map Event Spot) button on the toolbar at the bottom of the Live panel, and the current 

connection in the selected camera screen is released.  The map event spot screen is surrounded by a gray 

outline. 

3. When an event is detected, video from the event-detected is displayed on the map event spot screen. 
 

 

 

 
 

 

 

 

 

 
[Map] CAM3: 

An event is detected.  

 
 

 

Layout Monitoring 
 

You can monitor video from multiple cameras in a predefined layout.  A layout should be registered on the 

REVO Remote Pro program for layout monitoring.  Refer to the following explanation for details about 

layout registration. 

 
NOTE: A “layout” in this manual refers to a screen organization created by arranging specific cameras in a 
specific screen format. 
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Select a desired layout from the Layout list.  Then, drag&drop 

it on the Live screen, or double-click on the layout.  Video 

from cameras added to the Layout is displayed in the 
predefined screen format on the screen. 

 
 
Registering Layout Groups 
 

1. Go to the System menu, and click Setup, and select the Device menu. 
 

2. Click Layout in the Site panel, and then the  button at the bottom of the Site panel on the left.  The 

Add Layout Group window appears. 
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Registering Layouts 
 

1. Go to the System menu, and click Setup, and select the Device menu. 
 

2. Click Layout in the Site panel, and then the  button at the bottom of the Site List panel on the right.  

The Add Layout window appears. 
 

 

 

 

 

 Name: Enter the layout name. 

 Sharing: Specify the users who can see the layout being registered.  The admin user can see all 
layouts. 

− Public: Displays the layout to all users. 

− Group: Displays the layout to a specific group of users.  You can select the group from the Owner list. 
− Private: Displays the layout to the individual users selected from the Owner list. 
 Owner: Allows you to display a different layout to different users. 

 Site: Displays a list of registered devices, cameras or camera sequences.  You can search for a registered 

device or camera sequence by entering text beside the  icon.  Entering text that you want to search 

for causes the search results to be displayed.  Search results are displayed immediately as matching 
text is found.  As you enter more text, the results narrow. 

 Screen Format: Select a screen format for the layout to be registered.  Select a device, a camera or 

camera sequence to assign to the layout in the Site panel, and drag and drop it in the desired camera 
screen of the layout screen. 

  (Remove): Selecting a camera screen in the layout screen and clicking this button deletes the camera 
assigned to the camera screen from the layout screen. 

  (Hotspot): Selecting a camera screen in the layout screen and clicking this button sets up the camera 
screen as a hotspot screen. 

  (Event Spot): Selecting a camera screen in the layout screen and clicking the button sets up the camera 
screen as an event spot screen. 

  (Map Event Spot): Selecting a camera screen in the layout screen and clicking the button sets up 
the camera screen as a map event spot screen. 
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  (Camera Sequence): Selecting a camera screen in the layout screen and clicking this button allows 
you to create a camera sequence and assigns the created camera sequence to the camera screen. 

 

Clicking the OK button completes registration of the layout. 
 

 

Layout Sequence Monitoring 
 

You can monitor video from multiple cameras sequentially in more than one predefined layout.  A layout 
sequence should be registered on the REVO Remote Pro program for layout sequence monitoring.  Refer to 

the following for details about layout sequence registration. 

 
NOTE: A “layout” in this manual refers to a screen organization created by arranging specific cameras in a 
specific screen format. 
 

1. Select a desired layout sequence from the Layout Sequence 
list, and drag and drop it on the Live screen.  Video from 

cameras added to the layout sequence is displayed in the 

screen format for each layout sequentially. 

 
 

2. Clicking the  (Layout Sequence) button of the toolbar at the bottom of the panel stops or starts the layout 

sequence. 
 

 
 
Example 
 

  
  

Layout 1 Layout 2 
 

 

 

 

 

 

 

 

  

         

Layout Sequence 

 
Registering Layout Sequences 
 

1. Go to the System menu, and click Setup, and select the Device menu. 
 

2. Click Layout Sequence in the Site panel, and then the  button at the bottom of the Site List panel 

on the right.  The Add Layout Sequence window appears. 
 

3. If no layout to be sequenced is registered, click the Add Layout button.  The Add Layout window appears.  
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Register layouts to sequence referring to Layout Monitoring (p. 47).  At least two layouts must be 
registered for sequencing. 

 

 

 

 

 

 

 

 

 
 

 Name: Enter the layout sequence name. 

 Sharing: Specify the users who can see the layout sequence being registered.  The admin user can 
see all layout sequences. 

− Public: Displays the layout sequence to all users. 

− Group: Displays the layout sequence to a specific group of users.  You can select the group from the 

Owner list. 
− Private: Displays the layout sequence to the individual users selected from the Owner list. 
 Owner: Allows you to display a different layout sequence to different users. 

 Layout List: Displays a list of registered layouts.  You can search for a registered layout by entering 

text beside the  icon.  Entering text that you want to search for causes the search results to be displayed.  

Search results are displayed immediately as matching text is found.  As you enter more text, the results 

narrow. 
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 Selected Layout Sequence List: Displays the list of layouts registered for the layout sequence.  

Duration (sec) displays the duration for each layout to be displayed on the screen.  Clicking twice 

on the number under Duration (sec) for a layout will allow you to change the duration time for this 

specific layout.  Clicking the Apply all button applies the duration setting to all layouts in the list. 
 

Select a layout from Layout List, click the  button, and the selected layout is added to Selected Layout 
Sequence List.  Clicking the OK button completes registration of the layout sequence. 
 

 

Camera Sequence Monitoring 
 

You can monitor video from multiple cameras in the same camera screen sequentially.  A camera sequence 

should be registered on the REVO Remote Pro program for camera sequence monitoring.  Refer to the 

following for details about camera sequence registration. 

 

1. Select a desired camera sequence from the Camera 
Sequence list, and drag and drop it on the Live screen.  
Video from cameras added to the camera sequence is 

displayed on the screen sequentially. 

 
 

2. Clicking the  (Camera Sequence) button on the camera screen control toolbar 

stops or starts the camera sequence. 

 
 
Example 
 

  
  

Camera 1 Camera 2 
 

 

 

 

 

 

 

 

  

         

Camera Sequence 
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Registering Camera Sequences 
 

1. Go to the System menu, and click Setup, and select the Device menu. 
 

2. Click Camera Sequence in the Site panel, and then the  button at the bottom of the Site List panel 

on the right.  The Add Camera Sequence window appears. 
 

 

 

 

 

 Name: Enter the camera sequence name. 

 Sharing: Specify the users who can see the camera sequence being registered.  The admin user can 
see all camera sequences. 

− Public: Displays the camera sequence to all users. 

− Group: Displays the camera sequence to a specific group of users.  You can select the group from the 

Owner list. 
− Private: Displays the camera sequence to the individual users selected from the Owner list. 
 Owner: Allows you to display a different camera sequence to different users. 

 Device List: Displays a list of registered devices.  You can search for a registered device by entering 
text beside the  icon.  Entering text that you want to search for causes the search results to be displayed.  

Search results are displayed immediately as matching text is found.  As you enter more text, the results 

narrow. 

 Selected Camera Sequence List: Displays the list of cameras registered for the camera sequence.  

Duration (sec) displays the duration for video from each camera to be displayed on the screen.  Clicking 

the Apply all button applies the duration setting to all cameras in the list. 
 

Select a camera from Device List, click the  button, and the selected camera is added to Selected 
Camera Sequence List.  Clicking the OK button completes registration of the camera sequence. 
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6.2  Map Monitoring 
 

You can monitor video from cameras, event detection and input/output device status on a map for devices 

registered on the REVO Remote Pro program.  A map should be registered on the REVO Remote Pro 

program for map monitoring.  Refer to Chapter 11 — Map Editor (p. 89) for details about map 
registration. 

 
Map monitoring is supported in the Live panel (maximum 4) and Map panel.  If the Live or Map tab is not 

on the tab panel, go to the System menu, click New Tab, and then Live or Map. 
 

Select a desired map from the Map list, and drag and drop it on 
the Live screen.  The selected map is displayed on the screen.  

You can move a map to the desired location on the Live screen 

without disconnecting the current connection while monitoring 

video.  Selecting an input/output device on the map, and dragging 

and dropping it on the Live screen, Play panel or Device Status 

panel allows you to monitor or play back video or to monitor 

device status. 

 
 

 
 

Hovering the mouse cursor over the input/output device on the map displays the event detection and status 

of the input/output device.  When the input/output device detects any event or is not working properly, the 

following icons appear sequentially to the maximum of 4 at a time (some event icons may not be supported, 
depending on the specifications and version of the device): 
 

 Unplugged  Event-Off  Irregular  Motion 

 Video Blind  Video Loss  Object Detection  Video Analytics Detection 

 Trip-Zone  Tampering  Audio Detection  Alarm-In 

 Alarm-Out       

 
Event detection is displayed according to the event detection settings, and Irregular is based on the system 

check settings on the device that the input/output device is connected. 
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Event detection and status are displayed in unique colors if you have set up status color during the map setup.  

When more than one event or status is detected at the same time, the color reflecting each event detection 

or status is displayed sequentially. 

 
Path Sequence 
 

You can monitor video from multiple cameras sequentially on a map in the same camera screen during map 

monitoring.  A path sequence should be set up for path sequence monitoring.  Refer to 11.2 Setting up 
Map, Path Sequence (p. 92) for details about the path sequence setup. 
 

Select a desired path of the path 

sequence from the map, and drag and 

drop it on the Live screen.  Video from 

the cameras associated to the path 

sequence is displayed sequentially 
during the preset duration period. 

 
 

 

6.3  Controlling Cameras 
 

A control toolbar and a screen menu are provided for controlling camera. 

 
Control Toolbar 
 

When selecting a camera screen and hovering the mouse cursor over the camera screen, the control toolbar 

is displayed over that camera screen.  The control toolbar allows you to control the selected camera.  Hovering 
the mouse cursor over a button displays a tooltip for the button. 
 

 

  (PTZ Control): Allows you to control PTZ for a camera that supports 

PTZ control.  Refer to PTZ Control (p. 57) for details. 

  (Fisheye Dewarping): Dewarps the fisheye camera image.  Refer to 

Fisheye Dewarping (p. 60) for details.  

  (Color Control): Adjusts the brightness, contrast, saturation and hue of 
the current video.  Clicking the  button cancels the adjustment and 

reloads the original image.  This change will be applied to both the video 

of the REVO Remote Pro program and the device. 

  (Image Effect): Adjusts the image effect.  Refer to Image Effect (p. 61) for details. 

  (Image Zoom): Zooms in on the image.  Refer to Zoom Control (p. 60) for details. 

  (Camera Sequence): Starts or stops camera sequence.  Refer to 6.1 Monitoring Video, Camera 
Sequence Monitoring (p. 52) for details. 

  /  (Listen/Talk): Receives audio from the device or sends audio to the device (Not all devices 
support audio). 
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  (Text-In Viewer): Pops up the text-in viewer window (supported only when a text-in event is detected).  

The camera title bar is highlighted in blue when a text-in event is detected.  Refer to Text-In Viewer (p. 62) 
for details. 

  (Instant Playback): Allows you to use the Instant Playback function for the section with the recording 

information.  Refer to Instant Playback (p. 61) for details. 

  (Panic Recording): Starts or stops the panic recording.  During panic recording, the Panic Recording 

icon is displayed in the upper-right corner of the camera screen. 
NOTE: The panic recording is a function that allows you to manually record video which is currently being 
monitored. 

  (Google Map): This feature is only supported with vehicular DVRs/NVRs. 

  (Speed Graph): This feature is only supported with vehicular DVRs/NVRs. 

  (Vehicle Info): This feature is only supported with vehicular DVRs/NVRs. 

 
Live Screen Menu 
 

The screen menu is displayed when selecting a camera screen and clicking the right mouse button.  The 

screen menu allows you to control the selected camera. 

 

 

 Fisheye Dewarping: Dewarps the fisheye camera image.  Refer to Fisheye 
Dewarping (p. 60) for details.  

 Instant Playback: Allows you to use the Instant Playback function for the section 

with the recording information.  Refer to Instant Playback (p. 61) for details. 

 Play History: Saves 8 instant playback history in maximum for each camera 

device and plays the history. 

 Misc.: Sets the Instant Playback options. 

 Play Recorded Data: Displays the recorded image of the selected screen on the 

play tab. 
 PTZ Control, Color Control, Image Zoom, Listen, Talk, Panic Recording: 

These function the same as clicking the individual buttons on the control toolbar.  

Refer to Control Toolbar (p. 55) for details. 

 Camera Sequence Monitoring: Allows you to move, start, stop, pause and exit 

the camera sequence monitoring (supported only for sequence monitoring). 

 Image Processing: Adjusts the image effect.  Refer to Image Effect (p. 61) for 

details. 

 Alarm-Out: Activates or deactivates alarm out. 

 Text-In Viewer: Pops up the text-in viewer window (supported only when a 
text-in event is detected).  The camera title bar is highlighted in blue when a 

text-in event is detected.  Refer to Text-In Viewer (p. 62) for details. 

 NVR Listen/Talk: Receives audio from the NVR device or sends audio to the 

NVR device. 

 Audio Broadcast: Broadcasts audio to all devices in the current Live tab. 

 MultiStream: Allows you to choose the desired stream if the device is in the multistream mode for live 
monitoring. 

 Hotspot: Sets up a selected camera screen as a hotspot screen.  Refer to Hotspot Setup (p. 46) for 

details. 

 Event Spot: Sets up a selected camera screen as an event spot screen.  Refer to Event Spot Setup (p. 

46) for details. 
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 Map Event Spot: Sets up a selected camera screen as a map event spot screen.  Refer to Map Event 
Spot Setup (p. 47) for details. 

 Draw Motion Block: Displays the area where motion is detected with red blocks when a motion detection 

event occurs for the selected camera (supported only for connection of network video transmitters). 

 Draw Face Detection: Displays the area where face is detected with blocks when a face detection event 
occurs for the selected camera. 

 Aspect Ratio: Select the proper image aspect ratio. 

− Fit to Screen: Displays images by fitting them to the screen size regardless of the aspect ratio. 

− Fit to Screen (Aspect Ratio): Displays images by fitting them to the screen size keeping the aspect 

ratio.  This might cause top and bottom or left and right side of images to be cropped depending on the 

screen size.  This aspect ratio is not supported and Original Ratio is applied for camera screens that 
the following functions are activated: Image Zoom, Hotspot, Event Spot, Draw Motion Block. 

− Original Ratio: Displays images by fitting them within the screen size while maintaining their original ratio. 

− Half Size (x0.5) to Quadruple Size (x4): Selecting the desired image size displays images in the selected 

size.  Options are enabled if the selected camera screen can display images in that size. 

 Save Still Image: Saves the current image on the screen as an image file at its original size. 

 Remove: Disconnects the current connection. 
 

 

PTZ Control 
 

Clicking the  (PTZ Control) button on the control toolbar displays the PTZ control toolbar and allows you 

to control PTZ.  Depending on the PTZ camera specifications, some features may not work. 

 

  (Direction Control): Displays or hides the  (Direction Control Panel).  You 
can control the direction of the PTZ camera by clicking the arrow buttons on 

the direction control panel or by clicking and dragging the mouse on the camera 

screen. 

  (OneClick Move): Controls Pan-Tilt to move the user’s point to the center 

of the screen (only works for some models of Network Camera connections).  

See  
 PTZ OneClick Move Control (p. 59) for an explanation of this function. 

  (Zoom In/Out): Zooms the camera lens in or out. 

  (Focus Far/Near): Focuses on near or far objects. 

  (Iris Open/Close): Opens or closes the iris of the camera lens. 

  (Set/View Preset): See PTZ Preset Control (p. 58) for an explanation of this function. 

  (One Push): Automatically adjusts focus when the image is out of focus after the image is zoomed 
in or out (only works for some models of Network Camera connections). 

  (Advanced Menu): Displays the Advanced Menu window and allows you to use more features that 
the PTZ camera supports.  Refer to the PTZ camera manufacturer’s manual for details about additional 

features. 

  (Close): Exits the PTZ mode and returns to the control toolbar. 
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PTZ Preset Control 
 

You can save camera directions as a Preset so that you can move the camera directly to a saved direction. 

 
1. Move the PTZ camera to the desired position. 
 

2. Click the  (Set Preset) button on the PTZ control toolbar, and the Set Preset 
window appears.  Enter a name for the Preset and click the OK button.  The 
current position is saved as the Preset name. 

 
 

3. Click the  (View Preset) button on the PTZ control toolbar, and the View 
Preset window appears.  Select the desired Preset, and the PTZ camera moves 
to the position of the selected Preset. 
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ePTZ Control 
 

You can control Pan, Tilt, and Zoom function more accurately. 
NOTE: This is supported only for some models of camera. 

 

 

Controls Pan, Tilt, and Zoom function.  Dragging the mouse, the 

size of dragging indicates the speed of PTZ. 
 Left button drag: Left/Right (Pan control), Up/Down (Tilt 

control) 
 Right button drag: Zoom control 

 

 
PTZ OneClick Move Control 

 
You can control Pan-Tilt to move your point to the center of the screen.  You can move the position 

exactly you want with minimum input. 
 
NOTE: This is supported only for some models of camera. 
 

 

Clicking the  (OneClick Move) button on the control toolbar 

and any point of PTZ camera pane moves anywhere you want.  

Dragging the mouse zooms the part of screen. 
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Fisheye Dewarping 
 

Clicking the  (Fisheye Dewarping) button on the control toolbar displays the fisheye dewarping toolbar 

and allows you to dewarp fisheye image.  The mount type set in the device is a default. 

 

 

  (Mount Type): Choose a position that the camera is mounted.  

The available Screen Type changes depending on this setting. 

  (Image Ratio): Select the proper image aspect ratio. 

  (Layout): Select the layout, Main View and Main + 1~7 

panes mode. 

  (Panoramic): Select the panoramic mode. 

  (Selection Mode): Drag and drop the area in the main view 

screen. 

  (Spot Mode): Move and select the area with the dewarp 

finder in the main view screen. 

  (Drag and Drop): Move and copy the main view and camera 

pane. 

  (Main PiP): Displays PiP (Picture in Picture) view to select the area easily in the main view screen. 

  (ePTZ): Controls Pan, Tilt, and Zoom function.  Dragging the mouse, the size of dragging indicates the 

speed of PTZ. 

− Left button drag: Left/Right (Pan control), Up/Down (Tilt control) 

− Right button drag: Zoom control 

  (Auto Pan): Set to pan the camera automatically.  +,- for direction and numbers for speed. 

  (Load/Save Preset): Load the saved preset of fisheye video control and save the current fisheye 

video control as preset. 

  (Display Source Image): Cancels the adjustment and reloads the original image. 
 

Fisheye Quick Control 

 
When in fisheye live mode, you can turn it into the fisheye dewarping by using a keyboard and a mouse 

without selecting the ePTZ mode.  
 

 Quick Zoom 

− Ctrl + Mouse left button drag (Original Image): Zoom in the area selected by the mouse drag.  

− Ctrl + Mouse left button drag: Moves the zoomed in image to the position where the mouse drag moves. 

− Ctrl + Mouse wheel click: Exits the zoom image view and returns to the original image. 

− Ctrl + Mouse wheel scroll: Zoom control 

 Quick Dewarping 

− Ctrl + Mouse left button drag (Original Image): Dewarps the area selected by the mouse drag.  

− Ctrl + Mouse left button drag: Pan/Tilt control in the mouse drag directions. 

− Ctrl + Mouse wheel click: Exits the dewarping image and returns to the original image. 

− Ctrl + Mouse wheel scroll: Zoom control 

 Quick PTZ 

− Ctrl + Mouse left button drag: Pan/Tilt control in the mouse drag directions. 

− Ctrl + Mouse wheel scroll: Zoom control 

− Ctrl + Mouse right button drag: Zoom control 

− Ctrl + Shift + Mouse left click/drag: Move the image to the position where you click becomes the center, 

or move the image following the mouse drag. 
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Zoom Control 
 
Clicking the  (Image Zoom) button on the control toolbar allows you to zoom in on the current video. 

 
NOTE: “PIP” is an abbreviation of Picture in Picture and describes a smaller screen within a screen. 

 

 

Dragging the mouse on the camera screen moves the zoomed-in area. 
 

  (Slide Bar): Adjusts the enlargement ratio.  You can adjust the 

enlargement ratio also by using the mouse scroll wheel. 

  (Actual Size Zoom): Enters the actual size zoom mode.  In the actual size 
zoom mode, the image is displayed in its original size regardless of the camera 

screen size or image’s aspect ratio. 

  (Zoom Finder): Displays or hides the PIP screen.  The rectangle in the PIP 
screen indicates the zoomed-in area. 

 

 

Image Effect 
 
Clicking the  (Image Effect) button on the control toolbar displays the image effect control toolbar and 

allows you to control image effect.  This change will be applied to only the video of the REVO Remote 

Pro program and not to the device. 
 

 
 

  (Blur): Blurs the image to reduce noise. 

  (Sharpen): Sharpens an image. 

  (High-Boost): Increases the brightness and contrast of images. 

  (Histogram Equalization): Equalizes the image brightness to make it more natural. 

  (Edge Detection): Extracts the image edge. 

  (Revert): Cancels the adjustment and reloads the original image. 
 

 

 

Instant Playback 
 

You can use Instant Playback function for the section with the recording information.  Click the  (Instant 

Playback) button on the control toolbar and select a playback time on the popup menu.   
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 Hovering the mouse cursor over the screen allows you to 

use Exit, Bookmark, Play, and Forward/Backward buttons. 

 Using the left/right arrow buttons and PageUp/PageDown 

buttons allows moving the playback point. 

 Select reverse playback and slow playback from the 

context menu of the image. 

 

 

 The status of playback appears on the camera title bar. 

 Clicking the inverted triangle image beneath the camera 

title bar displays a thumbnail image.  When the thumbnail 

image is enabled, hovering the mouse cursor on the camera 

title bar displays the image of the corresponding site. 

 Clicking a specific point on the camera title bar moves to 

the corresponding site. 

 

 

Text-In Viewer 
 

Clicking the  (Text-In Viewer) button on the control toolbar displays the text-in viewer window and 

allows you to check the text-in data in real-time (supported only when a text-in event is detected).  The 

camera title bar is highlighted in blue when a text-in event is detected. 
 

 

 

Clicking the title bar in the Text-In Viewer 

window displays a text-in popup menu. 

 

 All Attach: Docks all text-in viewer windows in one panel. 

 Save As: Saves the text-in data as a text file (.txt). 

 Time Range: Set up the length of time for text-in data to be displayed when a text-in event occurs.  You 
can check the text-in data in the text-in viewer window within the established time range for the event. 
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6.4  Controlling Maps 
 

A control toolbar and a screen menu are provided for controlling a map. 

 
Control Toolbar 
 

When selecting a map and hovering the mouse cursor over the map, the control toolbar is displayed over 

that map.  The control toolbar allows you to control the selected map.  Hovering the mouse cursor over a 

button displays a tooltip for the button. 
 

 

 ,  (Previous Map, Next Map): Moves to the previous or next connected 
map of the maps that have been connected to the current map screen.  Maps 

can be connected by using map link or by selecting a map from the map list 

and dragging and dropping it on the current map screen. 

  (Auto Focusing): Enlarges the area where the event-detected device is placed 
when any event is detected.  When events are detected in more than one device 

at the same time, the canvas is enlarged as much as possible while still displaying 

all event-detected devices.  When events are detected in more than one device 

consecutively, the focusing moves to the later detected event after the preset 

time expires.  Refer to 5.14 Map (p. 42) for details about the auto focusing 
setting. 

  (Focusing Event): Allows you to select a desired event for auto focusing. 

  (Actual Size (x1)): Displays a map in its original size regardless of the map screen size or canvas’s 
aspect ratio. 

  (Zoom Finder): Displays or hides the PIP screen.  The rectangle in the PIP screen indicates the enlarged 

area.  When set to Auto, the PIP screen is displayed only while a canvas is enlarged. 

  (Zoom In): Allows you to adjust the enlargement ratio of the canvas. 

 



User’s Manual 

 
 

64 

Example 
 

 When Zoom Finder is set to Off; 
 

Map Monitoring  Event Detection  Auto Focusing 
     

 

 

 

 

 
 

 

 When Zoom Finder is set to Auto or On; 
 

Map Monitoring  Event Detection  Auto Focusing 
     

 

 

 

 

 
 
 

 
Map Screen Menu 
 

The screen menu is displayed when selecting a map screen and clicking the right mouse button.  The screen 

menu allows you to control the selected map. 
 

 

 Previous, Next, Auto Focusing, Actual Size (x1), Zoom Finder, Zoom In: 
These function the same as clicking the individual buttons on the control toolbar.  

Refer to Control Toolbar (p. 55) for details. 

 List: Displays the list of the previous or next connected maps.  Selecting a map 
from the list moves to the selected map. 

 Reload: Reloads the connection of the current map. 

 Focusing Event, Focusing Duration: Allows you to set up auto focusing events 

and duration.  Refer to 5.14 Map (p. 42) for details. 

 Save Still Image: Saves the current image on the screen as an image file at its 

original size. 

 Remove: Disconnects the current connection. 
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Live Popup 
 
Popup Screen 
 

You can monitor live video from a camera with a detected event during map monitoring.  Popup screens 

appear based on the settings in Map Editor (Event property – Live Popup action) when events are detected.  

The Live Popup list displays the list of live popup screens currently displayed on the monitor. 
 

 

When selecting a popup screen and hovering the mouse cursor 

over the popup screen, the control toolbar is displayed over that 

popup screen.  The control toolbar allows you to control the 

camera.  Hovering the mouse cursor over a button displays a 

tooltip for the button.  Refer to 6.3 Controlling Cameras, 
Control Toolbar (p. 63) for details about the toolbar buttons. 
 

When clicking the right mouse button on the popup screen, a 
popup screen menu is displayed.  The screen menu allows you 

to change the popup screen settings or to control the camera.  

Items related to controlling a camera in the menu function the 

same way as those in the live screen menu.  Refer to 6.3 
Controlling Cameras, Live Screen Menu (p. 56) for details. 

 
Live Popup List 
 

 
 

Clicking the arrow button in the upper right corner displays 

a live popup menu.  The live popup menu allows you to 
change the popup screen settings. 

 

 Layout: Select the display format of popup screens. 

 Monitor: Select the monitor on which popup screens are displayed if you use dual monitors. 

 Ignore Live Popup: Select a time span to disable the live popup function regardless of the settings in 

Map Editor (Event property – Live Popup action – Duration). 

 Disable Time Out: Click if you want to close the popup screen manually regardless of the preset duration 
for the popup screen to be displayed. 

 Remove All: Deletes the list. 
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Chapter 7 — Recorded Video Playback & Exportation 
 
 

You can play back recorded video or export recorded video to USB devices. 

 

 

7.1  Playing back Recorded Video 
 

1. Search and playback of video recorded in a device or the REVO Remote Pro system are supported in 

the Play panel (maximum 4).  If the Play tab is not on the tab panel, go to the System menu, click New Tab 

and then Play. 
 

 

 

 

2. Click the Play tab on the tab panel → Select a site to connect 

from the Site list and drag and drop it on the Play screen.  
Recorded video from the selected site is displayed on the 

screen.  You can move a camera screen to the desired 
location on the Play screen without stopping the current 

playback while playing back video.  Select a camera screen 

and drag and drop it on the desired location. 

 
 

If a layout is registered on the REVO Remote Pro program, you can play video in the layout format by 

selecting a desired layout from the Layout list and dragging and dropping it on the Play screen.  Refer 

to 6.1 Monitoring Video, Layout Monitoring, Registering Layouts (p. 49) for details about the 
registration of a layout. 

 

NOTES:  

 The REVO Remote Pro system performance might deteriorate when simultaneously monitoring or playing 
back multiple videos on a PC with a low specification. 

 A “layout” in this manual refers to a screen organization created by arranging specific cameras in a specific 
screen format. 

 

3. A panel toolbar, a timetable, a control toolbar and a screen menu are provided for playing back recorded 

video. 

 
Panel Toolbar 
 

The toolbar at the bottom of the panel allows you to search and play back recorded video. 
 
NOTE: The toolbar may be different and some functions below may not be supported, depending on the 
specifications and version of the device. 
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OR 
 

 
 

  /  (Event Search/Time-Lapse Search): Switches search mode between event search and time-lapse 

search.  Refer to Timetable/Event List (p. 69) for details. 
  (Search Filter): Sets search conditions for event search.  Refer to the device’s user manual for details 

about the search condition. 
  (Calendar): Searches video for a specific date.  Selecting a date displays the recorded data for that date 

in the timetable.  The dates containing recorded images are enabled in the calendar. 

  (Move to): Searches video for a specific time. 

− Go To: Displays a time setup window.  Entering a specific time moves to the image for that time. 

Selecting Load Adjacent Frame moves to the image for the nearest time if there is no image at that 

time. 

− Move First: Moves to the first recorded image in the data displayed in the timetable. 

− Move Last: Move to the last recorded image in the data displayed in the timetable. 

  (Additional Menu): Displays a menu. 

− Data Source: Selects the data source to be searched. 

 Search on Local: Searches recorded data on primary storage installed in the DVR. 

 Search on Archive: Searches archived data on backup storage installed in the DVR. 

 Search on Other: Searches recorded or archived data on Storage used for another DVR then installed 
in the DVR.  This may not be supported, depending on the specifications and version of the DVR. 

− Overwrite Protection: Checks the recorded video with overwrite protection in the device. 

− Add Bookmark: Bookmarks the recorded video.  

− Remote Site Panel: Displays or hides a site list in the floating panel or full screen.  Not every panel 
supports this function. 

− Text-In Panel: Displays the text-in panel. 

− Select Segment: Allows you to select a video segment when the Recorder’s time and date have been 
reset to a time that is earlier than previously recorded video and there is more than one video segment in 

the same time range due to time overlap (supported only for Recorders which provide the hour segments 

timetable). 

  (Export Video File): Exports recorded video as a self-player file (.exe) or an AVI file (.avi).  Refer 

to 7.2 Exporting Recorded Video (p. 75) for details.  
− Save Still Image: Saves the current image on the screen as an image file at its original size. 

− Export Image File, Print Image: Exports or prints the images currently displayed on the screen. 

− Export Panorama Screen: Exports the images on the screen of all panels. 

  (Bookmark): Allows you to bookmark the selected recorded video, play or remove the added 

bookmark. Refer to Bookmark (p.72) for details. 

  (Event on Play): Displays the list of events if there is event-recorded video among the video that is 
currently being played back.  Double clicking an event from the list displays the event-recorded video. 

  (Snapshot on Motion Event): Displays snapshot of images recorded during the event-based recording 

(event and pre-event) in the Play panel.  Refer to Snapshot on Motion Event (p. 72) for details. 

  (Text-In Panel): Displays the Text-In panel.  The Text-In panel shows the text-in data of devices 
currently connected to the REVO Remote Pro system.  If a camera is associated with the text-in device and 

video of the associated camera is displayed on the current Play screen, the text-in data is displayed 

overlapping video on the camera screen, too.  You can change the length of time for the text-in data to be 

displayed at the Live Text-In Time Range setting.  Refer to 5.10 Instant Event (p. 38) for details 

about the Live Text-In Time Range setting. 
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  (Step Playback): Moves the video forward or backward based on the setting displayed between the 
 and  buttons.  Clicking the arrow between the  and  buttons allows you to change the interval 

the video moves. 

  /  (Fast Backward/Fast Forward): Plays back recorded video fast backward or fast forward. 

  /  (Stop/Play): Stops or plays recorded video of the selected device. 

  (Jog Shuttle): You can adjust the playback direction and speed by using the jog shuttle.  
The vertical line in the jog shuttle indicates the current playback direction and speed.  Video is played 

backward when the vertical line is to the left of center and video is played back forward when the vertical 

line is to the right of center.  The farther the position is from the center, the faster the video is played 

back.  Clicking the vertical line and dragging it to the desired position on the jog shuttle and holding it 

plays video at a constant speed.  Releasing the mouse button causes the vertical line to return to the 

center position.  Clicking the  (Play) button plays video at normal speed.  Clicking the  (Shuttle 

Lock) button and dragging and dropping the vertical line to a desired position fixes the vertical line in that 

position. 

  (Jog Shuttle): You can adjust the playback speed by using the jog shuttle.  The vertical 

line in the jog shuttle indicates the current playback speed.  

  /  (Play on Tab/Pause on Tab): Plays or pauses playing recorded video of all devices displayed on 
the current screen. 

  (Save to User Layout): Saves the current screen format. 

  (Screen Format): Changes the screen format.  Clicking the  button 
displays additional screen formats.  Clicking the  or  button moves to the previous or next camera groups. 

 
Timetable/Event List 
 

 Time-Lapse Search Mode: When in the time-lapse search mode, the timetable is displayed at the bottom 
of the screen and it displays the recording information for each camera.  Clicking the  button in the top 

right corner of the timetable displays the recording information for all cameras.  Clicking the  button 

displays the recording information for the selected camera on the screen. 
 

 
 

NOTE: The timetable will differ depending on the model of the device. 
 

① Current Playback Date/Time: Indicates the video time for the current playback location on the 

timetable. 

② Recorded Period: Displays the date and time period of the recorded data.  Clicking anywhere in the 

empty space and dragging it to the left or right moves to the earlier or later date or time.  Scrolling 

the mouse wheel while holding the Ctrl key on the keyboard zooms in and out the time section. 

③ Camera Title: Displays the camera title. 

④ Recorded Data: Displays the recorded data by time in one minute or one hour segments depending 

on the device. 

 Second, Minute Segments Timetable (all devices except some DVR models) 
− Red vertical line: Indicates the current playback location of video on the timetable.  Clicking the 

mouse on the desired time displays the first image recorded within the time. 
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− Yellow separation line: Separates segments when time overlap occurs.  In this case, the recorded 
data in the time range located after the separation line is the latest.  Clicking the  (Calendar) 

button in the Play panel allows you to move to a specific segment directly (Click the  (Calendar) 
button → Select a date → Select a segment → The first image recorded within the selected segment 

is displayed on the screen). 

− The color of the bar: Indicates different recording modes (Blue for Time-lapse, Purple for Event, 
Yellow for Pre-event, Pink for Event and Pre-event, Red for Panic Recording and Green for 

Irregular recording caused by temporary disconnection from the device). 

− Moves the recorded image by 1 second~1 minute according to the timetable magnification. 

 Hour Segments Timetable (some DVR models only) 
− Yellow color bar: Indicates the current playback location of video on the timetable. 

− Pink color bar/Gray color bar: Indicates the segment of video that is currently displayed/not 
displayed on the screen when time overlap occurs.  Clicking the  (Additional Menu) button 

in the Play panel allows you to change the segment to be displayed on the screen (Click the  

(Additional Menu) button → Select the Select Segment menu → Select a desired segment → 
The first image recorded within the selected segment is displayed on the screen). 

 

NOTE: If the REVO Remote Pro system’s or device’s time and date have been reset to a time that is earlier 
than previously recorded video, it is possible that there is more than one video segment in the same time 
range due to time overlap.  In this case, you can individually play video that was recorded during the 
overlapping time by selecting a segment. 
 

For example, when the REVO Remote Pro system or device 
has recorded video from one to five o’clock and the user 
changes the time backward from five to three o’clock and 
then continues recording until six o’clock, there will be two 
segments from three to five o’clock.  
 
 Event Search Mode: When in the event search mode, the event list is displayed at the bottom of the screen 

as follows.  When searching for video recorded on an SD (SDHC) memory card, not all events are 

searched but only the events that occurred while recording on an SD (SDHC) memory card is enabled. 
 

 
 

Clicking an event from the list displays the event-recorded video on the screen if the events were recorded 

during Event recording.  Clicking the  button in the top right corner of the event list displays next 

results.  Clicking the  button, setting the time, and selecting the event goes to the previous recorded 

data as the time you set. 

 
Control Toolbar 
 

The control toolbar is displayed over a selected camera screen when hovering the mouse cursor over the camera 

screen.  Hovering the mouse cursor over each button displays a tooltip for the button. 
 

 

  (Fisheye Dewarping): Dewarps the fisheye camera image.  Refer to 

Fisheye Dewarping (p. 60) for details.  
  (Object/Motion Search): Allows you to search for changes or motion in 

recorded images in the device or the REVO Remote Pro system.  Refer to 

Object/Motion Search (p. 73) for details. 

  (Image Zoom): Zooms in on the image.  Refer to Zoom Control (p. 74) 
for details. 
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  (Color Control): Adjusts the brightness, contrast, saturation and hue of the current video.  Clicking 
the  button cancels the adjustment and reloads the original image.  This change will not be applied 

to the recorded video. 

  (Image Effect): Adjusts the image effect.  Refer to Image Effect (p. 61) for details. 

  (Audio Play): Plays audio when playing back video that has recorded audio (1x1 screen format only). 
 
Play Screen Menu 
 

The screen menu is displayed when selecting a camera screen and clicking the right mouse button. 
 

 

 Fisheye Dewarping: Dewarps the fisheye camera image.  Refer to 

Fisheye Dewarping (p. 60) for details.  

 Image Zoom: Functions as the same as clicking the button in the control 

toolbar.  See Control Toolbar (p. 70) for details. 

 Image Processing: Enhances playback images.  Refer to Control 
Toolbar (p. 70) for details. 

 Motion/Object Search: Allows you to search for changes or motion in the 
recorded images in the device or the REVO Remote Pro system.  Refer to 

Object/Motion Search (p. 73) for details. 

 Draw Face Detection: Displays the area whether face is detected with blocks when a face detection 

event occurs for the selected camera. 

 Aspect Ratio: Select the proper image aspect ratio. 

− Fit to Screen: Displays images by fitting them to the screen size regardless of the aspect ratio. 

− Fit to Screen (Aspect Ratio): Displays images by fitting them to the screen size keeping the aspect 
ratio.  This might cause top and bottom or left and right side of images to be cropped depending on the 

screen size.  This aspect ratio is not supported and Original Ratio is applied for camera screens that 
the following function is activated: Image Zoom. 

− Original Ratio: Displays images by fitting them within the screen size while maintaining their original 
ratio. 

− Half Size (x0.5) to Quadruple Size (x4): Selecting the desired image size displays images in the 
selected size.  Options are enabled when the selected camera screen can display images in that size. 

 Save Still Image: Saves the current image on the screen as an image file at its original size. 

 Remove: Disconnects the current connection. 
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Bookmark 
 
Clicking the  (Bookmark) button on the panel toolbar allows you to bookmark the selected recorded video. 

 

 

 

 
 
 

 

 

1. Click the  (Add Bookmark) button. 

2. Enter the bookmark name and description.  

Clicking the Add button bookmark the recorded 
video. 

3. Clicking a bookmark from the bookmark list 

displays the bookmark information at the bottom.  

Clicking the  (Play Recorded Data) button 

displays the bookmarked video on the Play screen.  

Clicking the   (Remove Bookmark) button 

deletes the bookmark. 

 

 

Snapshot on Motion Event 
 

Clicking the  (Snapshot on Motion Event) button on the panel toolbar displays snapshot of images recorded 

during the event-based recording (event and pre-event) in the Play panel. 

 

 
 

The timetable displays the recording information of the selected snapshot.  Clicking anywhere on the recorded 

data in the timetable displays a snapshot of the selected time.  Hovering the mouse cursor over each snapshot 

displays a popup viewer screen above the snapshot. 
 

 

 Use Popup Viewer: Enables display of the popup viewer screen. 
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Object/Motion Search 
 
Clicking the  (Object/Motion Search) button on the control toolbar displays the object/motion search panel 

at the bottom and allows you to search for changes or motion in recorded images in the device or the REVO 

Remote Pro system. 
 

 

  (Draw Search Zone): Allows you to define the area to search for changes 

or motion on the camera screen by dragging the mouse.  The search zone is 

displayed with red blocks. 

  (Erase Search Zone): Allows you to erase the search zone set on the camera 
screen by dragging the mouse. 

  (Set Ref. Image): Sets the image currently displayed on the camera screen 
as a reference image for change detection (Object Search only). 

  (View Ref. Image): Displays or hides a PIP screen with the reference image 
(Object Search only). 

 

 
 

 
 

 Find Method: Selects a search method. 

− Motion Search: Searches for images with changes in the Search Zone between two consecutive images 
(for example, when there was movement). 

− Object Search: Searches for images with changes which last for the Activation Time in the Search 
Zone when compared to the reference image (for example, when an object disappeared). 

 Sensitivity: Sets the sensitivity of the change detection.  The higher the number is, the more sensitive 

it is. 

 Num of diff. block: Sets the minimum number of blocks that must be activated to be considered as a 

change (Motion Search only). 

 Diff. % to ref. image: Sets the minimum proportion (%) of blocks that must be activated to be considered 
as a change (Object Search only). 

 Activation Time: Sets the duration that the change must last to be considered as a change.  If a change 
is detected but does not last as long as the Activation Time, the change is not considered as a change. 
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Zoom Control 
 
Clicking the  (Zoom) button on the control toolbar allows you to zoom on the current video. 
 

NOTE: “PIP” is an abbreviation of Picture in Picture and indicates the smaller screen within a screen. 
 

 

Dragging the mouse on the camera screen moves the zoomed-in area 
 

  (Slide Bar): Adjusts the enlargement ratio.  You can adjust the 

enlargement ratio also by using the mouse scroll wheel. 

  (Actual Size Zoom): Enters the actual size zoom mode.  In the actual size 
zoom mode, the image is displayed in its original size regardless of the camera 

screen size or image’s aspect ratio. 

  (Zoom Finder): Displays or hides the PIP screen.  The rectangle in the PIP 
screen indicates the zoomed-in area. 

 

 

Image Effect 
 

Clicking the  (Image Effect) button on the control toolbar displays the image effect control toolbar and 
allows you to control image effect.  This change will not be applied to the recorded video. 
 

 
 

  (Blur): Blurs the image to reduce noise. 

  (Sharpen): Sharpens an image. 

  (High-Boost): Increases the brightness and contrast of images. 

  (Histogram Equalization): Equalizes the image brightness to make it more natural. 

  (Edge Detection): Extracts the image edge. 

  (Revert): Cancels the adjustment and reloads the original image. 
 

 

Smart Image Filter 
 

Clicking the  (Smart Image Filter) button on the left bottom of the recorded image allows you to apply 
filters to an image according to the status of the image or purpose. 
 

 

 Auto, Defog, Lowlight: Applies filters and set each value. 

  ROI Spot: Applies filters to the selected area only. 

  High-Boost: Applies high-frequency enhancement filter. 
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7.2  Exporting Recorded Video 
 

You can export recorded video to USB devices.  Click the  (Export Video File) button on the toolbar at 

the bottom of the panel, and the export menu is displayed. 
 

 
 

 A-B Export Video File: Sets up the section of video to be exported by using the timetable.  Select A-B 
Export Video File from the export menu.  Click the starting point and ending point to specify an area. 

The Export Video File window appears and allows you to export video of the selected period as a 

self-player file (.exe) or an AVI file (.avi).  Refer to Exporting as a Self-Player File (p. 76) and 

Exporting as an AVI File (p. 80) for details. 
 

 
 

 Export Video File: Sets up the section of video to be exported by entering the date and time manually.  

Select Export Video File from the export menu.  The Export Video File window appears and allows 

you to export video for the period as a self-player file (.exe) or an AVI file (.avi).  Refer to Exporting 
as a Self-Player File (p. 76) and Exporting as an AVI File (p. 80) for details. 

 Export Text-In Data: Exports the text-in data in a text format (.txt) file. Set up the range for the text-in 

data to save. 

 Reserved Self-Player: Displays the list of reservations of exporting as a self-player file.  Clicking the  
button performs the reserved exporting manually, and clicking the  button cancels the reservation.  Refer 

to Exporting as a Self-Player File (p. 76) for details about reservation of exporting as a self-player file. 

 Save Still Image: Saves the current image on the screen as an image file at its original size. 

 Export Image File, Print Image: Exports or prints the images currently displayed on the screen. 

 Export Panorama Screen: Exports the images on the screen of all panels. 
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Exporting as a Self-Player File 
 
The recorded video is exported as a self-player file (.exe). 

 

 

 From, To: Enter the date and time of video to export.  

Selecting First sets the date and time to the date and 

time of the first recorded video.  Selecting Last sets 
the date and time to the date and time of the last 

recorded video.  Clicking the  1 Minute,  3 
Minute,  10 Minute,  30 Minute or  60 Minute 
button increases or decreases by the selected amount 

from the time selected on the timetable. 

 Self-Player, AVI: Select Self-Player. 

  Save Password: Set up a password for playing 
back the exported video.  You will be asked to enter 

the password to initiate the Player program. 

  Save Keyframes Only: Saves the keyframe only 
as the interval you set. 

  Include Text-In Data: Includes text-in data when 

saving video if the video was recorded with text-in data. 

 

  Exclude Player: Saves the recorded data without including the Self-Player program.  The file size 

will be smaller, and it will take less time to save, but you will need to run the Self-Player program 

(ClipPlayer.exe) which is provided in the REVO Remote Pro installation folder (\Client\selfplayer) to 
play the saved file.  This may not be supported, depending on the specifications and version of the device. 

  Reservation: Reserves a time to perform exporting.  In the reserved time, the REVO Remote Pro 

system performs exporting with the settings above. If the device is disconnected during exporting and 

exporting fails, the REVO Remote Pro system retries exporting at the selected interval. 
 

NOTE: When the data file reaches 2GB, you will be asked to continue saving by creating multiple files in 
2GB units. 

 

Playing Self-Player File 
 

You do not need to install any special software to play video exported as a self-player file because the self- 

player file contains a player program (Clip Player).  Double clicking the target file starts the Player program, 
and video is displayed on the screen.  Clicking the slide bar at the bottom of the Player program displays 

the playback image of the selected time on the screen.  Clicking the  button exits the Player program. 

 
NOTE: It is suggested that the computer used for the Player program has at least an 800MHz Pentium III 
(Intel Pentium Dual Core 2.2GHz recommended).  If your CPU is slower than this, video clips recorded at 
maximum speed with very high image quality will be played back slowly.  Also DirectX 9.0 or higher is 
required to install, and the VGA card with 16MB or higher video RAM is recommended for proper operation. 
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NOTES:  

 Proper image display depends on the display settings of your PC.  If you are experiencing display problems, 
click the right mouse button on the background screen and select Properties → Settings then set the Color 
quality to “32 bit”.  Then select Advanced → Troubleshoot, and then set the Hardware Acceleration to 
“Full”.  Please make sure that DirectX version 9.0 or higher has been installed if the display problem continues.  
To check the version of DirectX, click Start → RUN and type “dxdiag” then hit the enter key which will display 
DirectX Diagnostic Tool dialog box.  Then move to the Display tab and make sure DirectDraw Acceleration 
is set to “Enabled”.  Test DirectDraw by selecting the DirectDraw Test button when using the Microsoft®  
Windows®  XP operating system.  Please check the driver version of the video card and update it to the 
latest version available.  If you still have display problems after changing all display settings as described 
above, try replacing the video card.  Video cards with an ATI chipset are recommended. 

 If you selected the Exclude Player option when saving recorded video, you must run the Self-Player program 
(ClipPlayer.exe) which is provided in the REVO Remote Pro installation folder (\Client\selfplayer) to play 
the saved file. 

 It is required to have Window Vista or a higher operating system for Fisheye Dewarping.  Fisheye 

Dewarping is supported in the 1x1 screen format only.  You can control by clicking the right mouse button 

on the screen. 
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  : Goes to the beginning of the video.  : Goes to the end of the video. 

 : Plays the video in fast reverse.  : Plays the video in fast forward. 

 : Goes backward one frame of the video.  : Goes forward one frame of the video. 

 : Plays the video at regular speed.  

  : Shows the previous camera group if there is recorded video in the previous camera group based on 
the current screen format. 

  : Cycles through the screen formats.  It cycles through 2x2, 1+7, 3x3, 4x4, 4x5, 5x5 and 1+32. 

  : Shows the next camera group if there is recorded video in the next camera group based on the current 
screen format. 

  : Sets up the properties of the player program. 
 

 

− Fisheye Dewarping: Controls Fisheye Dewarping.  Refer to the following 

Dewarp menu for more accurate functions. 
− Print: Prints the current image. 

− Frame Info.: Displays Channel, Title, Time, Type, Size and Resolution 
information about the image. 

− Image Processing: Controls brightness, blur and sharpness of playback 
images. (1x1 screen format only) 

− Play Speed Control: Changes the playback speed (Play) or fast 

forward/backward playback speed (FF/RW). 

− Drawing Mode: Selects the draw mode level.  If you are not sure about the 
best draw mode level for your system, try each level until the image displays 

properly. 

− Screen Size: Changes the screen size of the player program. 

− Aspect Ratio: Changes the image aspect ratio displayed on each 
camera screen. 

− OSD Setup: Changes the basic settings on each camera screen. 

− Enable Audio: Plays audio while playing back recorded video that has recorded audio. (1x1 screen 
format only) 

− Anti-Aliasing Screen: Enhances image display quality on the screen by smoothing stair-stepping (aliasing) 
effects in the enlarged image.  If video plays slow because of your CPU’s slow speed, releasing the 
Anti-Aliasing Screen option might improve playback speed. 

− Show Text-In: Displays text-in data if the video was recorded with text-in data.  In the single-screen 

layout, text-in data is displayed with images on the screen.  In multi-screen layouts, click the right mouse 

button on a camera screen and then a text-in menu. 
− Continuous File Play: Plays the files that compose the split file successively.  For example, if video is 

split to 3 files of abc_01.exe, abc_02.exe and abc_03.exe when it is saved, you don’t need to play 

each file one by one manually.  When you play the abc_01.exe file, abc_01.exe, abc_02.exe and 
abc_03.exe files will be played successively. 

− Move to Previous File: Moves to the previous file from the currently playing file or the file to be played 

when playing a split file. 

− Move to Next File: Moves to the next file from the currently playing file or the file to be played when 
playing a split file. 

− File List: Lists the files that compose the split file in sequence.  Selecting a file from the list moves to the 

selected file. 

− Repeat Playback: Playback again after playing the recorded file. 

− Check Fingerprint: Checks the validity of the entire file segments. 
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  : Saves the current images. 
 

 

− Save as Image: Saves the current image as a bitmap or JPEG file. 

− Save as Image (Actual Size): Saves the current image as a bitmap or 
JPEG file in its actual size. (1x1 screen format only) 

− Save as Clip-Copy: Saves video of desired time range as an executable file. 

− Save as Video: Saves video of desired time range as an AVI file. 
− Clip-Copy Log: Saves the clip copy log information as a text file.  The user 

information about Save As Clip Copy will be logged as Internal-Copy. 

− Save Frame Info: Saves the frame information as a CSV file. 
 

  : Selects the image size option to enlarge the image or display the image in its actual size (1x1 screen 
format only).  You can move the enlarged image by clicking the left mouse button and dragging. 

  : Displays the image in the full screen. 

 ,  : Is displayed at the bottom-right corner of the screen.   indicates that the clip file has not been 
tampered with, and  indicates that the system has detected tampering and playback stops. 

 Fisheye Dewarping 

 

 

− Mount Type: Chooses a position that the camera is mounted.  The available 

Screen Type changes depending on this setting. 

− Main View: Displays the original fisheye dewarping video.  When ePTZ is 

on, you can control Pan, Tilt and Zoom by clicking the left/right mouse 

button. The Main PiP is selected as a default. 

− Panoramic/Panoramic 180/Panoramic 180 * 2: Selects the panoramic 

Mode. 

− Spot Mode: Moves and selects the area with the dewarp finder in the main 

view screen. 

− Main PIP: Displays PiP (Picture in Picture) view to select the area easily in 

the main view screen. 
 

− ePTZ: Controls Pan, Tilt, and Zoom function.  Dragging the mouse, the size of dragging indicates the 

speed of PTZ. The left button drag controls Left/Right (Pan) and Up/Down (Tilt). The right button drag 

controls Zoom. 

− Display Source Image: Cancels the adjustment and reloads the original image. 
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Exporting as an AVI File 
 
The recorded video is exported as an AVI file (.avi). 

 

 

 From, To: Enter the date and time of video to export.  

Selecting First sets the date and time to the date and 

time of the first recorded video.  Selecting Last sets 
the date and time to the date and time of the last 

recorded video.  Clicking the  1 Minute,  3 
Minute,  10 Minute,  30 Minute or  60 Minute 
button increases or decreases the time by the selected 

amount from the time selected on the timetable. 

 Self-Player, AVI: Select AVI. 

  Include Audio Data: Includes audio data when 
saving video with recorded audio.  This option is not 

available when more than one camera is selected.  

Audio might not be saved properly when the recording 

speed is set to less than 1 ips. 

 Codec, Bitrate, Quality: Set up the desired values for 
compressing the file. 

− Encoding Based on Bitrate: Encodes video based 
on the bitrate.  Selecting this option enables the 

Bitrate setting below. 
− Encoding Based on Video Quality: Encodes video 

based on the quality.  Selecting this option enables 

the Quality setting below. 

 Size: Set up the file size for compressing the file. 

− Original Ratio: Saves images with fitting within the screen size while maintaining their original ratio. 

− Fit to Screen: Saves images with fitting to the screen size regardless of the aspect ratio regardless of 
the aspect ratio. 

− Fit to Screen (Aspect Ratio): Saves images with fitting to the screen size keeping the aspect ratio. 
This might cause top and bottom or left and right side of images to be cropped depending on the screen 

size.  This aspect ratio is not supported and Original Ratio is applied for camera screens that the 
following function is activated: Image Zoom. 

  Anti-Aliasing: Enhances image display quality for all cameras on the screen by eliminating stair-stepping 
(aliasing) effects in the enlarged image. 

 Keyframe: Sets up the keyframe for compressing the file. 

 Max. File Size: Sets up the maximum file size. 

  Save Split File: Exports video by creating multiple files of the Max. File Size units set above when 
the data file reaches the maximum file size.  If this option is not selected, it exports only as much as the 

maximum file size. 

  View Proceeding Frames: Displays a popup window showing the video currently being exported. 

 
Playing AVI File 
 

Run the video player program and open the exported AVI file.  If the codec selected during exporting video 

as an AVI file is not installed, you will need to install the codec manually. 
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Chapter 8 — Event Handling 
 
 

You can monitor live video from a camera where an event is detected or play back event-recorded video 

if video of the selected event has been recorded. 

 

 

The REVO Remote Pro system is notified events from registered devices and 

displays the events in the Instant Event List in the following cases: 
 

 The device is connected for monitoring on the Live tab of the REVO Remote 
Pro system 

 The Device Real-Time Monitoring option is enabled for the device in the 

REVO Remote Pro system (Setup > Device > device menu: Edit Device > 

Information tab).  Refer to 5.1 Device, Managing Devices, Editing Device 
Information, Information (p. 20) for details about enabling the Device 
Real-Time Monitoring option. 

 

You can change the options of the event list display during Setup – Instant 
Event.  Refer to 5.10 Instant Event (p. 38) for details. 

 

The description of event icons which are displayed in the event list is as follows (some event icons may not 

be supported, depending on the specifications and version of the device): 

 

 Motion Detection  Video Blind  Video Loss 

 Object Detection  Audio Detection  Video Analytics Detection 

 Trip-Zone  Tampering  Text-In 
 /  Alarm-In On/Off  /  Alarm-In Bad/Good  /  External Storage In/Out 
 /  Device Connected/Disconnected  System Boot Up 
 System Alive  System Restart  System Shut Down 
 Recorder Bad  Disk S.M.A.R.T.  Disk Bad 
 Disk Full  Disk Almost Full  Disk Config Change 
 Disk Temperature  /  Panic Recording On/Off  /   Fan Error On/Off 
 Face Detection  /    PIR Detection On/Off  /   ANPR Detection On/Off 

 /  Auto-tracking Detection On/Off  /  Alarm Box Error/Off 

/   Main Stream Recording/Error /   Sub Stream Recording/Error 
 

Emergency Event 
 

If a notify function that notifies an event when the event occurs is enabled for each event in a registered 

device, the device considers an event as an emergency event when the event is detected.  The REVO 

Remote Pro system is notified emergency events from the device in the following cases: 
 

 The device is set to notify this REVO Remote Pro system of emergency events.  However, it is possible 

that emergency events do not occur if the device is connected for monitoring on the Live tab of the REVO 

Remote Pro system, depending on the specifications and version of the device. 

 The device is not set to notify this REVO Remote Pro system of emergency events and the device is 
connected for monitoring on the Live tab of the REVO Remote Pro system. 

 The device is not set to notify this REVO Remote Pro system of emergency events and the Device 
Real-Time Monitoring option is enabled for the device in the REVO Remote Pro system (Setup > 

Device > device menu: Edit Device > Information tab).  Refer to 5.1 Device, Managing Devices, 

Editing Device Information, Information (p. 20) for details about enabling the Device Real-Time 
Monitoring option. 

 

For this function to work, a callback port should be set up correctly.  Refer to 5.10 Instant Event (p. 38) 
for details about setting up the callback port. 
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The Emergency Event panel appears automatically when emergency events are occurred, or you can display 

the Emergency Event panel manually as follows: 

 

Go to the View menu, click Emergency Event Panel.  Or, click the  button in the Instant Event List. 
 

 

OR 

 

 

The Emergency Event panel is displayed. 
 

 
 

 Event Count: Displays the total number of events in the list. 

 Last Event: Displays information of the recently occurred event. 

 Auto Popup : Pops up the Emergency Event panel automatically when the REVO Remote Pro 

system is notified of an event. 

 Event, Device, Site, Date/Time: Displays information of the event.  Selecting an event from the list 
and dragging and dropping it on the Live or Play screen displays on the screen live video or event-recorded 
video from the camera where the selected event occurred. 

 

 



REVO Remote Pro (Remote Administration System) 

 
 

83 

Monitoring Video 
 
Monitoring video from a camera where an event is detected is supported in the Live panel (maximum 4).  

If a Live tab is not on the tab panel, go to the System menu, click New Tab and Live. 
 

 

 

 

Click the Live tab in the tab panel → Select a desired event 

from the event list and drag and drop it on the Live screen.  
Live video from the camera where the selected event occurred is 

displayed on the screen. 

 
 

 

Playing Video 
 

Playing event-recorded video is supported in the Play panel.  If the Play tab is not on the tab panel, go to 

the System menu, click New Tab and Play. 
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Click the Play tab on the tab panel → Select a desired event 

from the event list and drag and drop it on the Play screen.  

The event-recorded video is displayed on the screen. 
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Chapter 9 — System Health & Status Monitoring 
 
 

You can simultaneously check the system status and device status of registered devices. 

 

 

9.1  Health Monitoring 
 

System health monitoring is supported in the Health panel.  If the Health tab is not on the tab panel, go to 

the System menu, click New Tab and Health. 
 

 

 

 

The REVO Remote Pro program automatically displays the health monitoring results when the Health 

tab is added. 
 

 
 

 Summary List: Displays the health monitoring status of devices for all device groups in summary. 

− Total: Displays the number of devices in all device groups. 

− Problem: Displays the number of devices where a problem is detected. 

− Unreachable: Displays the number of devices that are not connected. 

− Healthy: Displays the number of devices where no problem is detected. 

 Detailed List: Displays the status of each device in detail (The status may not be displayed depending 

on the device). 

− Status: Displays the status (Healthy: No Problem detected; Problem: Video loss event is detected, 

alarm in device error or recording error; Unreachable: The device is not connected). 

− Problem: Displays details regarding the problem. 

− Group: Displays the list of device groups that the device is registered on. 

− Site: Displays the device name. 

− Address: Displays the device’s IP address. 

− MAC Address: Displays the device’s MAC address. 

− Version: Displays the system version information. 

− Cameras: Displays the status of cameras that are enabled in the device. 

− Alarm In: Displays the status of alarm-in devices that are enabled in the device. 

− Fan: Displays the fan error status. 

− Record: Displays the recording status. 

− Record Check: Displays the recording check status. 

− Record Period: Displays the recording period. 
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 Function Buttons 
−  (Refresh): Displays the newest information of the health monitoring panel. 

−  (Save): Saves the data of the health monitoring panel in .txt, .csv and .html formats. 

−  (Full Screen): Displays the Status panel in full-screen format. 
 

 

9.2  Status Monitoring 
 

Device status monitoring is supported in the Status panel.  If the Status tab is not on the tab panel, go to 

the System menu, click New Tab and Status. 
 

 

 

 

Select a device to connect to from the Site list, and drag and drop it on the Status panel.  The status of the 
selected device is displayed. 
 

 
 

 
 

 Status Display Window: Displays the status as icons. 

− Camera: Displays the camera numbers. 

− Version: Displays the system version information. 

− Event: Displays the status of event detection.  When an event is detected, the icon is displayed in 
corresponding color.  Hovering the mouse cursor over an icon displays the event type in a tooltip. 

− Alarm Out: Displays status of the alarm-out signals. 

− System Check: Displays the function status of the device and recording. 

 Function Buttons 

−  (Disconnect): Disconnects the current connection on the Status panel. 

−  (Panic Recording): Starts or stops panic recording remotely (supported only for DVRs with the panic 
recording function). 

− Rec. From/To: Displays the recording period. 

− Status: Displays the status of recording, playback, archiving, exporting of recorded video. 

−  (Full Screen): Displays the Status panel in full-screen format. 
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Chapter 10 — Log Search 
 
 

You can search log entries for the REVO Remote Pro program and the devices. 

 

Log search is supported in the Report panel.  If the Report tab is not on the tab panel, go to the System menu, 

click New Tab and Report. 
 

 

 

 

The various types of log entries are displayed.  Clicking the right mouse button on a column header displays 

a menu and allows you to sort data as you want. 

 

 
 

 Log type: Select a log type to search from the drop-down list. 

− User Log: Displays log entries from the REVO Remote Pro program. 

− Health Log: Displays log entries of the system health monitoring for the registered devices. 

− Device System Log: Displays system log entries from the devices. 

− Device Event Log: Displays event log entries from the devices.  If the device is a network camera or 
network video transmitter, not all event logs are displayed but only the events that occurred while 

recording on an SD (SDHC) memory card is enabled. 

− Admin Service Log: Displays log entries from the administration service.  Ask your dealer or distributor 
for details. 

− Monitoring Service Log:  Displays log entries for monitoring service.  Ask your dealer or distributor 
for details. 

  (Incremental Search): Allows you to search for a log.  Entering text that you want to 
search for causes the search results to be displayed.  Search results are displayed immediately as matching 

text is found within the selected group.  As you enter more text, the results narrow. 
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Report Toolbar 
 

The toolbar at the bottom of the panel allows you to search for the desired log entries. 

 

 
 

 From, To: Set up the date and time of the log entry to search.  Enter a specific date and time or select 

First or Last.  Clicking the 1 Hour, 6 Hour, Today, 3 Day or 1 Week button adjusts the time interval 

between From and To.  Selecting First or Last searches log entries from the first or to the last. 

  (Condition): Selects a log type to search. 

  (Search): Starts searching log entries based on search conditions. 

  (Full Screen): Displays the Report panel in full-screen format. 

  (Export): Exports the searched log entries as a text file (.txt), CSV file (.csv) or a PDF file (.pdf).  
System and service log entries can also be exported as an encrypted HTML file (.html) which will ask you 

to enter a password to view the file. 

  (Print): Prints the searched log entries. 

 More: Displays more results. 
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Chapter 11 — Map Editor 
 
 

You can register a map to monitor video from cameras, event detection and input/output device’s status of 

devices registered on the REVO Remote Pro program on a map on the REVO Remote Pro system. 

 

 

11.1  Registering Map 
 

1. Go to the System menu → Select Setup → Select Device. 
 

2. Click Map in the Site panel, and then the  button at the bottom of the Site List panel on the right.  The 

Map Editor window appears. 
 

  

 

 

 

3. Select an input/output device connected to a device or a sub-map in the Site panel and drag and drop it 
on the canvas. 

 

4. Set up the map.  Refer to 11.2 Setting up Map (p. 90) for details. 
 

5. Entering a map name and clicking the OK button completes registration of the map. 
 

6. Select Map in the Site panel and click the  button on the bottom of the left Site panel to create a map 
group. 
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11.2  Setting up Map 
 

 
 

① Site: Displays a list of registered devices and map.  You can search for a registered device and map by 

entering text beside the  icon.  Entering text that you want to search for causes the search results to 

be displayed.  Search results are displayed immediately as matching text is found.  As you enter more 
text, the results narrow. 

② Canvas: Allows you to create a map by inserting a background image and placing input/output device 

icons or map links from the Site list. 

③ Setup Buttons: Sets up the map. 

− Align: Aligns the input/output device icons or map links on the canvas. 

−  (Text Box): Inserts a box which allows you to enter text. 

−  (Path Sequence): Sets up a path sequence.  Refer to Path Sequence (p. 92) for details. 
−  (Synchronize Map Objects Name): Synchronizes the input/output device’s name based on the settings 

in the device. 

−  (Background Image): Inserts a background image on a canvas. 

−  (Status Color): Sets up a unique color for each event detection or status of input/output devices. 
−  (Delete): Selecting an input/output device icon or a map link on the canvas and clicking this button 

deletes the icon or link from the canvas. 

④ Property: Sets up the property of the map, canvas, input/output device icons or map links. 

⑤ Event Action: Sets up the event action of the input/output device icons.  When you monitor video on 

the map and events are detected, notification on the map is made based on the event action settings. 
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Icon Alignment 
 

You can adjust the alignment on the canvas and size of one or more input/output device icons or map links 

at a time by selecting the icons or links and clicking the icon alignment button. 
 

 
 

  /  (Position): Aligns one or more icons to the center vertically or horizontally on the background image. 

  / ,  / ,  /  (Position): Aligns two or more icons to the top or bottom, to the vertical or horizontal 
center, or to the left or right based on the last selected icon. 

  /  (Distance): Equalizes the distance between each icon of three or more icons. 

  /  /  (Size): Equalizes the width, height, or size of two or more icons (supported only for icons 
that are of the same type but of a different width-height ratio). 

 
Property 
 

You can set up properties of the canvas, or input/output device icons or map links on the canvas.  Select 

the canvas, icons or map links, and then each field of the property.  You can enter or select a value from 

the drop-down list. 

 

       
 

 Map Attributes: Sets the properties of the map. 

− Root Map: Displays a list of devices registered on the map at the right of the Map panel during the map 
monitoring (supported only for the Map panel). 

 Canvas: Sets the properties of the canvas and background image inserted on the canvas. 

− Width, Height, Color: Sets the width, height and color of the canvas. 

− Image Position: Sets the position of the background image. 

− Information: Displays the width and height of the background image. 

 Input/Output Device: Sets the properties of the input/output device icon. 

− Name: Sets the name of the device icon. 

− Icon, Ratio: Sets the image and ratio of the device icon. 

− X Coordinate/Y Coordinate, Width/Height: Sets the position and size of the device icon.  You can 
also sets the position and size by using the mouse drag and drop on the canvas. 

− Associated Camera: Associates the device with a camera (supported only for an alarm in or audio-in 
device).  You can monitor video from the associated camera when an event is detected.  You can also 

set the map link for an alarm in device. 

− Halo Effect: Sets the color of the background of the icon.  It allows you to more easily find the device 
icon on the map. 

− Camera View: Sets the angle, pan, distance, etc (supported only for a camera). 

− Information: Displays the information about the device. 
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 Map Link: Sets the properties of the map link. 

− Name: Sets the name of the map link.  The name will be displayed on the map link. 

− X Coordinate/Y Coordinate, Width/Height: Sets the position and size of the map link.  You can also 
sets the position and size by using the mouse drag and drop on the canvas. 

− Text Color, Background Color: Sets the text color and background color of the map link. 

− Opacity: Sets the opacity of the background color of the map link. 

− Align Text: Aligns the name text of the map link. 

− Information: Displays the map name. 

 Text Box: Sets the properties of the text box. 

− Text: Sets the text.  The text will be displayed on the map. 

− Font, Font Size: Sets the font and font size. 

− Text Color, Background Color: Sets the text color and background color of the text box. 

− Align Text: Aligns the text. 

− Bold, Italic, Underline, Strikethrough: Makes the text bold, italicizes the text, underlines the text, 
draws a line through the text. 

− X Coordinate/Y Coordinate, Width/Height: Sets the position and size of the text box.  You can also 
sets the position and size by using the mouse drag and drop on the canvas. 

 
Path Sequence 
 
It allows you to set up a path sequence and monitor video from multiple cameras sequentially in the same 

camera screen during map monitoring.  A path sequence should be set up for each camera on the canvas 

for path sequence monitoring (Click the  (Path Sequence) button → Click each camera icon on the canvas 

in order of monitoring → Click the right mouse button to finish the setting). 

 

 

 Name: Sets the name of the path sequence. 

 Color/Opacity/Width: Sets the color/opacity/width of the path displayed 
on the map. 

 Shape: Sets the shape of the alert icon to distinguish a camera when 

displaying video from a camera set for the path sequence during map 
monitoring. 

 Background Color/Opacity/Margin: Sets the color/opacity/margin of the 

alert icon when displaying video from a camera set for the path sequence 

during map monitoring. 

 Reverse: Reverses the direction of the path sequence. 

 Associated Device: Displays the list of cameras set for the path sequence.  
Video from cameras in the list is displayed on the screen sequentially for the 

Duration period.  Clicking a camera in the list and the Disconnect button 
deletes the camera from the path sequence. 
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Event Action 
 

You can set up event actions to be taken when events are detected by the input/output devices.  Select the 

icon, and then each field of the property.  You can enter or select a value from the drop-down list. 
 

 

 Click: Sets the Instant Viewer window to be displayed when clicking the 
input/output device icon on the map.  When clicking an alarm-in icon, 

clicking activates or deactivates alarm out. 

 Motion Detection, Object Detection, Video Loss, Video Blind, Alarm 
In, etc.: Enables or disables event actions to be taken when each event is 

detected.  The event actions will be disabled regardless of the settings below 
if you disabled the event actions of the input/output devices during the map 

monitoring (Disabling event actions: Place the mouse cursor over the 

input/output device on the map → Click the right mouse button → Select 

Ignore Event Action). 

− Live Popup: Pops up video from a camera (associated camera if the device 
is not a camera). 

− Event Spot: Displays video from a camera (associated camera if the 
device is not a camera) on the event spot screen. 

− Event Sound: Sounds by playing back a selected audio file (.wav). 
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Chapter 12 — Controlling With a Network Keyboard 
 
 

You can control the REVO Remote Pro program by using a network keyboard. 

 
NOTE: This function is supported only for a specific model of a network keyboard which needs to be 
purchased separately. 

 

 

12.1  Registering 
 

1. Register the network keyboard on the REVO Remote Pro program: Go to the System menu → Select 

Setup → Select Device → Click  (Network Keyboard Setup) button, and the Network Keyboard 
Scan window appears.  The way to register a network keyboard is identical to the way to register a 

device.  Refer to 3.2 Registering Devices (p. 7) about registering a device. 
 

 

 

 

 

2. Register the REVO Remote Pro system on the network keyboard.  Refer to the network keyboard 
user’s manual for details. 

 

 

 ID (REVO Remote Pro system ID): The network 
keyboard assigns the ID automatically when the REVO 

Remote Pro system is registered, and you can change the 

ID.  The ID is used to distinguish the REVO Remote Pro 

system from other REVO Remote Pro systems when 

controlling it with a network keyboard, so each must have 

a unique ID. 

 Name: Set up a REVO Remote Pro system name for 
your reference. 

 IP Address: Enter the REVO Remote Pro system’s IP 

address.  Do not check Use DVRNS. 
 

 Control Port: Enter the Control port number set in the REVO Remote Pro System (Check the 

Control port number in the System menu → Setup → Network → Network Keyboard setting). 

 User ID, Password: Enter the user ID and password for the connection to the REVO Remote Pro 
system.  
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3. Enable a network keyboard in the REVO Remote Pro system by checking the Use Network 
Keyboard option. 

 

 

 

 
 

 

12.2  Connecting 
 
Network Keyboard LCD Display 
 

 

1. Press the REVO Remote Pro system ID on the network keyboard. 

 

 

2. Press the DEV button.  The network keyboard connects to the REVO Remote 
Pro system.  When the connection is succeeded, a unique ID is displayed on 

each camera screen and panel tab as follows. 
 

 
 

 

3. Pressing the SHIFT and DEV button at the same time releases the connection. 
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12.3  Operating 
 

 

Monitoring Video 
 

 

1. Press the Live tab ID on the network keyboard. 

 

 

2. Press the DEV button. 

 

 

3. Press the camera screen ID. 

 

 

4. Press the PANE button. 

 

5. Select a site to connect to from the Site list, and drag and 
drop it on the Live screen by using the mouse connected 

to the network keyboard.  Live video from the selected site 

is displayed on the screen. 

 
 

 

6. Press the  (Menu) button.  The live screen menu is displayed. 

 

7. Moving to the desired item by using arrow buttons and pressing the enter button 

(  ) selects the item in the menu or releases the selection.  If you want to exit 
the current item setting, press the  (Menu) button and releases the 

selection. 
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8. Refer to 12.4 Network Keyboard Buttons, Buttons for REVO Remote Pro System Control (p. 100) 
for the explanations about other functions. 

 

 

 

Playing Back Recorded Video 
 

 

1. Press the Play tab ID on the network keyboard. 

 

 

2. Press the DEV button. 

 

 

3. Press the camera screen ID. 

 

 

4. Press the PANE button. 

 

5. Select a site to connect to from the Site list, and then drag 
and drop it on the Play screen by using the mouse connected 

to the network keyboard.  Recorded video from the selected 
site is displayed on the screen. 

 

 
 

 

6. Press the  (Menu) button.  The play screen menu is displayed. 

 

7. Moving to the desired item by using arrow buttons and pressing the enter 

button (  ) selects the item in the menu or releases the selection.  If you 
want to exit the current item setting, press the  (Menu) button and releases 

the selection. 

 
 

8. Refer to 12.4 Network Keyboard Buttons, Buttons for REVO Remote Pro System Control (p. 100) 
for the explanations about other functions. 
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12.4  Network Keyboard Buttons 
 

The following is an explanation of the network keyboard buttons used to control the REVO Remote Pro 

system.  Refer to the network keyboard user’s manual regarding buttons for PTZ control. 
 

 

Buttons for Operation Commands 
 

Button Designation Operation 

 
Number (1 to 9) 

 ID → MON, PANE, DEV: Selects a monitor, camera screen, panel 

tab or REVO Remote Pro system to control. 

 
Number (0)  Does not function as a command button. 

 
Shift 

 SHIFT → Button : Performs the secondary function for buttons that 

support two functions. 

 
ESC  ESC : Cancels a command during its operation. 

 

Connection 
 REVO Remote Pro system ID → DEV : Connects to the REVO 

Remote Pro system. 

Disconnection 
 SHIFT & DEV : Releases the connection to the REVO Remote 

Pro system. 

Panel Tab  Tab ID → DEV : Selects the panel tab. 

 
Camera Screen  Camera Screen ID → PANE : Selects the camera screen. 

 
Monitor  Monitor ID → MON : Selects the monitor. 

 
– 

  : Releases the connection of the currently selected camera screen 

or device. 

 Function (1 to 8) 

 F1: Displays monitor ID when using more than one monitor. 

 F7 (SHIFT & F3) : Displays or hides the Setup screen (System 

menu → Setup). 

 F8 (SHIFT & F4) : Displays or hides the REVO Remote Pro 

program’s software version. 
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Buttons for REVO Remote Pro System Control 
 
NOTE: Some functions may not be supported, depending on the connected device. 
 

Button Designation Operation 

 

Panic Recording On 
 Camera Screen ID →  : Starts panic recording for the selected 

camera screen. 

Panic Recording Off 
 Camera Screen ID → SHIFT &  : Stops panic recording for the 

selected camera screen. 

 

Alarm Out On 

 Camera Screen ID →  : Activates the alarm out 1 of the device 

connected to the selected camera screen. 

 ‘Alarm-out device No.’ →  : Activates the selected alarm out. 

Alarm Out Off 

 Camera Screen ID → SHIFT &  : Deactivates alarm out 1 of 

the device connected to the selected camera screen. 

 ‘Alarm-out device No.’ → SHIFT &  : Deactivates the selected 

alarm out. 

 Display 

  : Allows you to change a screen format.  Select a screen format 

by using arrow buttons and enter button (  ). 

 SHIFT &  : Changes to the 1x1 screen format.  Pressing the 

button again returns to the previous screen format. 

 Group   : Moves to the next camera group. 

 

Freeze   : Freezes the current live images on the screen. 

Zoom 
 SHIFT &  : Zooms in the current live images on the screen.  You 

can move the zoomed-in area by using arrow buttons and enter 

button (  ). 

 Full Screen  ‘Panel tab ID’ →  : Displays the panel tab in full-screen format. 

 Search/Live 

  : Displays the Play panel and allows you to search and play 
back recorded video of the device connected to the selected camera 

screen in the Live panel is connected. 

 SHIFT &  : Returns to the previous Live panel. 

 

Fast Backward Play   : Plays video backward at high speed in the playback mode. 

Backward Step  SHIFT &  : Plays video backward image-by-image in the playback 

mode. 

 Play, Pause 
  : Plays back video.  Pressing the button while playing back 

video pauses the video. 

 

Fast Forward Play   : Plays video forward at high speed in the playback mode. 

Forward Step  SHIFT &  : Plays video forward image-by-image in the playback 

mode. 

 Menu  Displays the screen menu of the selected camera screen. 

 

Enter Button (  ) 
 Selects an item in the screen menu of the selected camera. 

 Toggles the zoom size when in the zoom mode. 
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Arrow Buttons 

 Navigates through items in the screen menu of the selected camera 

screen. 

 Moves the zoomed-in area when in the zoom mode. 

 

Jog Dial 

 Functions only when in the playback mode. 

 Zoom in/out the image by turning the jog dial. 

 Plays video forward or backward image-by-image by turning the 

jog dial clockwise or counterclockwise when playback video has 

been paused. 

 

Shuttle Ring 

 Functions only when in the playback mode. 

 Zoom in/out the image repeatedly by turning the shuttle ring. 

 Plays video when in the playback mode.  The shuttle ring is spring 

loaded and returns to the center position when released.  Turning 

the ring clockwise or counterclockwise plays video forward or 

backward.  The playback speed varies with the amount the ring is 

turned: fast forward and rewind. 

 Controls the playback speed when playing back video recorded in 

devices. 
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Appendix 
 
 

OSD Information 
 

The OSD (On Screen Display) is displayed in each camera screen in the Live screen of the REVO Remote 

Pro program. 

 

 

 Camera Title: Indicates the camera name set in the REVO Remote Pro 

program (upper left corner of the screen). 

  /  (Listen or Talk): Indicates the REVO Remote Pro system can receive 

audio from or sends audio to the device (upper right corner of the screen). 

  /  (NVR Listen or Talk): Indicates the REVO Remote Pro system can 

receive audio from or sends audio to the NVR device (upper right corner of 

the screen). 

  (PTZ): Indicates PTZ control is enabled (upper right corner of the screen). 

  (Instant Playback): Indicates the Instant Playback is enabled (upper right corner of the screen). 
  (Camera Sequence): Indicates the cameras are being sequenced (upper right corner of the screen). 

  (Orange: Is displayed during Panic Recording): Indicates video is being recorded in the REVO 
Remote Pro system (upper right corner of the screen). 

  (Zoom In): Indicates video is zoomed in (upper right corner of the screen). 

  (Color Control): Indicates the color control function is used (playback video only) (upper right corner 
of the screen). 

  (Image Effect): Indicates the image effect function is used (upper right corner of the screen). 

  (Freeze): Indicates images on the screen is frozen by a network keyboard (live images only) (upper 
right corner of the screen). 

 Date, Time: Indicates the date or time of the REVO Remote Pro system (bottom of the screen). 

 Event Alert: Indicates an event detected (highlights the camera title bar in red). 

 Motion Block: Indicates a motion event detected in the boxed area (on image) (supported only for network 
video transmitters). 

 

 

Troubleshooting 
 

Problem Possible Solution 

Monitoring is not available. 
 Check that devices have been added to a device group. 

 Check that you have authority for monitoring. 

The connection was released 
during monitoring and the 

REVO Remote Pro system 

repeats reconnecting. 

 Check the device status and the network connections for the device and 
REVO Remote Pro system. 

No live video. 
 Check the camera connections in the device. 

 Video display might lag because of system or network congestion. 

Event function does not 

work. 

 Check if the Device Real-Time Monitoring option is enabled.  If it is 

disabled, event related functions are supported only for the devices that 

are currently monitored. 
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Problem Possible Solution 

Two-way audio 
communication is not 

available. 

 Check the speaker and microphone connections in the device and the 
REVO Remote Pro system. 

 Check the audio input and output settings of the device. 
 Two-way audio communication is one-to-one communication.  If the 

device is already in audio communication with another system, try again 

when the other audio communication is disconnected. 

Cannot operate the REVO 
Remote Pro program 

because of wrong ID and 

password. 

 Uninstall and reinstall the REVO Remote Pro program.  You must delete 

all saved data, and the deleted data cannot be restored. 
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